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CAUTION

Any example data presented in this manual or available from website (these
include but are not limited to FEM element property data, FEM element
material data, weight and CG data, whiffletree diagrams, and whiffletree
material data) are fictitious values intended to illustrative purpose use only or
deliberately changed to unrealistic values due to proprietary reasons, and
should not be used to perform any analysis and/or calculations in your job.

Although every reasonable effort has been made to verify 3DWhiffletree
application software, end-users are fully responsible for any results produced
by the software including computed results and software errors.
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1.0 GENERAL

1.1 Copyright and Liability

3DWhiffletree Version 1.4.0 (released Rev 2015-08-13)
©2013-2014 Yoji Hosoe. All rights reserved.

This is a freeware. Sharing, copies and redistributions of this product are accepted; however, selling or
modifying this product is prohibited.

Although every reasonable effort has been made to verify 3DWhiffletree application software, end-users are
fully responsible for any results produced by the software including computed results and software errors.

1.2 Support

The following website can be used to access all resources for 3DWhiffletree software.

http://www.3dwhiffletree.com/

From the website, you can:

Download the latest version of 3DWhiffletree.exe

Download the latest 3DWhiffletree User's Manual

Request Product Key (It's free!)

Download sample files

View Demo/Tutorial Videos

Comment on the software (suggestion for improvement is welcome!)

1.3 System Requirement

This program will only work on Windows platform. This program does not require an installation package or
change in registry. However, it is assumed that .Net Framework 4.0 or higher is installed on the user’s PC.

1.3.1 .Net Framework

If an appropriate version of Net Framework is not installed on your computer, you will see an error message
saying something like “.Net Frame 4.0 is not installed” when you attempt to launch the program. If so, you
will need to download and install the correct version of .Net Framework. There are different versions of .Net
Framework depending on the Windows OS version. You can download it from the Microsoft website:

http://www.microsoft.com/net

For Windows XP or Windows 7 user, install .Net Framework 4.0.
http://www.microsoft.com/net/download/version-4

For Windows 8 user, install .Net Framework 4.5.
http://www.microsoft.com/visualstudio/eng/downloads#d-net-45

It may be possible to run this program with old version of .Net Framework in Windows XP machine.
However, it is known that certain display problems will occur.
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1.3.2 CATIA V5, Word 2010, Excel 2010

To have this program fully function, you will need the following applications installed on your computer.
Without these applications, some functions are limited as listed in Table 1-1. All other functions can be still

performed.
Table 1-1
Application Function
CATIA V5 or later version Export whiffletree into CATIA model
Word 2010 Export whiffletree diagram into Word Format
Excel 2010 Export whiffletree diagram into Excel Format

14 System File

This program requires a system file placed in the same folder where 3Dwhiffletree.exe is placed. The
system file will come with the application package, or you can download or request it

at http://www.3dwhiffletree.com/. The system file should be named exactly as the following (case not
sensitive):

3DWTSystem.ini

If the system file is missing, you will get the following error message (Figure 1-1). If you see this message,
check the system file if it is in the correct folder or has named correctly.

3DWhiffletree x|

|' W% 3DWTSystem.ini is not found!

R = 'I Please download a 3DWT Systern.ini file at:
http:/fwww . 3dwhiffletree.com/

Do you want to launch a browser to open 3dwhiffletree.com?

Figure 1-1

1.4.1 Product Key and Expiration Date

System file includes 40-digit alpha-numeric product key. Each product key is associated with an expiration
date (called “License Expiration Date”).

Once you start 3DWhiffletree program, you can check the product key and expiration date by the following
File Menu.
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Eile  Yiew  Whiffletree | Help

View Help

About 3DWhiffletree

Figure 1-2

You will see a window like one below and there you can find the product key and expiration date.

About 3DWhiffletree ==
3DWhiffletree
erzion 1.0 httpe i wew. 3dwhiffletree. com/
Released: 7/3/2013 Registered ID: Test]
2 2013 Yoji Hosoe Prodcut Key: smZxm-MRSro-FEZ2pb-cgVvhQ-vnb1n-UNVUbr-gvhyu-3el LB-tnayp-=xEmI7
All Rights Reserved License Expiration Date:  07/31/2013
Version Hisotry Description
1.0 TFIFE013 -
1.0 beta 1271372012

Figure 1-3

Once the product key (or “License”) has expired, you are no longer able to start the software. Then, you
need to request a new product key (or new system file) at http://www.3dwhiffletree.com/.. If you get a new
product key only, then open the file by text editor and replace the old product key in the system file and save
the system file.

In an event that the product key is expired, you will see a message (Figure 1-4) and program will not start.

In an event that the product key is invalid, you will see a message (Figure 1-5) and program will not start.
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IDWhiffletree x|

License expired on 12,/31/2013.
Please download a new 3DWTSystem.ini file at:

http:/ fwww 3 dwhiffletree.com/

Figure 1-4

3DWhiffletree X|

Key is invalid!

Figure 1-5

When you request a new product key only and replace the old one in the system file, you may get an error
message (Figure 1-6). This means there is the later version of 3DWhiffletree.exe. In such a case, you

cannot run the program anymore unless you obtain the latest version of 3DWhiffletree.exe associated with
the product key. This ensures that you use the most reliable version.

IDWhiffletree x|

It is detected that your software version is old. Please download the latest file.

Figure 1-6

1.4.2 Default Values in System File

The system file controls default values used in the program. Any lines start with a dollar mark (“$") are
considered as comments and will be ignored.
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Table 1-2

System File Description

Launch Mode
AirplaneCoordinate
4NodeQuadElement
3NodeTriangleElement

2NodeLineElement
SolidElemnt

WarningLength

WTRUnits

WTRDisplayDecimals

MTLDisplayDecimals

Only used for debugging purpose and user should not change
this value.

Defines default airplane coordinate system to be used when
you display axis in FEM/Whiffletree view window. (See Section
4.3.3)

Specifies 4-node Nastran plane element type to be read.
Specifies 2-node Nastran plane element type to be read.
Specifies 2-node Nastran line element type to be read.

Specifies Nastran solid element type to be read. For version
1.0 only CTETRA can be read.

Specifies a default minimum moment arm length that the
program provides a warning message. The warning can be
turned off from Whiffletree menu. (See Section 6.7.)

Defines default units used in the new whiffletree.

Defines default decimal places used in the new whiffletree.
See Section 6.8 for formatting rules.

Defines default decimal places used in the new whiffletree
material properties. See Section 7.4 for formatting rules.

If any of values in the system file is missing, you will see an error message and program will not start. Below
shows an error message when 3NodeTriangleElement is missing in the system file.

3DWhiffletree

Error in Systemn file. The following iterns were not found in the file.

3ModeTriangleElermnent

X/

Figure 1-7

1.5 Files — How files work each other

There are 7 types of files associated with 3DWhiffletree program, including main program (executable file),

as shown in Table 1-3.

General
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Table 1-3
File Name Description

3DWhiffletree.exe Main program runs 3DWhiffletree

3DWTSystem.ini System file that requires to run 3DWhiffletree.exe
(See Sectionl.4.)

*.d (*.dat) FEM files in Nastran format, used to display FEM
model. (See Section 1.5.1)

* witr Files that save information to construct whiffletree
(See Section 1.5.2)

*.mtl Files that save information of material used in
building whiffletree. (See Section 1.5.3)

*.CSV Files that is used to read loading points = weight
and CG data. (See Section 1.5.4)

*.col Files that save color associated with element

property ID (See Section 3.7)

Further explanations on certain types of files are shown below.

1.5.1 *d (*.dat)

This file is used to show FEM model in Model Window. The file can be directly created by preprocessors
(such as Femap or HyperMesh) or manually created. The format is same as Nastran and can be any of
Small-Field Format (8 columns for one entry field), Large-Field Format (16 columns for one entry field), or
Free-Format (comma delimited format). For Free-Field format, unlike Nastran’'s Free-Field format only
allows 8 characters per each entry field; this software can read any length.

When using “Include” statement, the following limitations apply.

Limitations using “Include” statement:

1. Use of “Include” statement is supported but referenced files must be relatively referenced from the
folder where 3DWhiffletree.exe is located. “Include” statement can be nested, that is, use of
“Include” inside “Include”-referenced file is accepted as deep folders as you want, and there is no
character length limit.

Example 1:
3DWhiffletree.exe is in C:\3DWhiffletree and you want to read a file of C:\3DWhiffletree\input.d

Correct:  INCLUDE “input.d’
Wrong: INCLUDE “C:\3DWhiffletree\input.d’

Example 2:
3DWhiffletree.exe is in C:\3DWhiffletree and you want to read a file of C:\3DWhiffletree\files\input.d

Correct: ~ INCLUDE “Ffiles\input.d’
Wrong: INCLUDE “C:\3DWhiffletree\files\input.d”’
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The FEM model in Model Window is only to display models and does not do anything with actual whiffletree
constructions or does not interact with other files (*.wtr, *.mtl, or *.csv). You still can read *.csv file for weight
and CG data, *.wtr for whiffletree, or *.mtl for materials without reading *.d file.

Grid Real Number Format:

Real number format for grid points (X, Y, Z) are generally same as Nastran format with one exception that it
may not need to contain a decimal point. Therefore, the following values are all acceptable formats for real
number seven (7).

7.0

7 (Nastran does not allow this as a real number)
.7E1

7E+1

0.7+1

0.70+1

7.E+0

70.-1

700E-2 (Nastran does not allow this as a real number)

152 *wtr

When you are creating whiffletree, you can save your work. Your work will be saved as *.witr file. This file
contains all information associated with the whiffletree (with some exceptions, see Table 5-2). See Section
5.2 for more details about file operation of *.wir file.

153 *mtl

You can save material properties for rod and beams used in whiffletree constructions. This will be saved as
*.mtl file. See Section 7.0 for more details about material and its use.

154 *.csv

Unlike *.wtr or *.mtl files, this file is what YOU will need to create so that Whiffletree.exe can read weight
and CG data. The weight and CG are essentially become loading points of the whiffletree.

The *.csv file is, as the name specifies, comma-separated values. You can create a *.csv file by using
spreadsheet application or by using text editors.

The first line in the file is reserved for a header and always required. Since the first line is ignored by
Whiffletree.exe, values do not matter. It is recommended to use the same header name as shown in the
Table 1-4.

General Rev 2015-08-13 1-7
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Table 1-4
Column No. Header Description Rule
1 Description Item Name Any Characters
2 Weight Item Weight Numeric values only (8-byte, double)
3 X Item Xcg location Numeric values only (8-byte, double)
4 Y Item Ycg location Numeric values only (8-byte, double)
5 4 Item Zcg location Numeric values only (8-byte, double)

Using Microsoft Excel:

This is the easiest way to create *.csv file.

1. Start MS Excel application and type values that look like Figure 1-8. In most cases users already have
weight and CG data in hand. In such cases, simply copy and paste the weight and CG data. Don't forget
to add a header in the first row.

A B C D E F

1 Description Weight X Y Z

2 | Structure 3959995 6069083 -79.7873 2434218
3 Cart (Fwd-Inbd) 150 6008 -1 22182
4 |Cart (Fwd-Otbd) 150 6008 87456 22192
5 |Cart (Aft-Inbd) 160 513.2 - 22182
6 Cart (Aft-Otbd) 150 513.2 8745 22192
T | Refrigerator 110 61847 -78.9 2562
8 Glass Rack Lower (Content) 15 600277 -7T4.6555 261884
9 Glass Rack Upper (Content) 15 600277 -74.6555  269.87
10 Attendant Module 36  B29.63 686 26787
11

12

Figure 1-8

2. Use “Save As” and choose “CSV (Comma delimited)” in “Save as Type”

General Rev 2015-08-13 1-8
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- Favorites
Bl Desktop
4. Downloads

| Recent Places

3 @ Galley_Example.csv

|1_—f|'iaveﬁ;s @
W - - S ; |
AN | , <« Projects » 3DWhiffletree » Manual - |€¢| Search Manual jel
Organize = Mew folder = - i@l
IE Microsoft Excel MName Date modified Type
1/15/201310:52 AM  Microsoft

- Libraries

- | 4|

UL

R CURGalley_Eample.csy
1T Rl Calley_Example.csy)

Save as type: [CS‘u’ (Comma delimited) (*.csv)

Authors: Yoji Hosoe

=~ Hide Folders

Tags: Add atag

Tools -

| |

Save

Cancel

Using Text Editors:

Figure 1-9

You can use any text editors to create *.csv files. The following basic rules apply (quoted
from http://en.wikipedia.org/wiki/Comma-separated values#Toward standardization).

e Each record "should" contain the same number of comma-separated fields.
Any field may be quoted (with double quotes).
Fields containing a line-break, double-quote, and/or commas should be quoted. (If they are not, the
file will likely be impossible to process correctly).

e A (double) quote character in a field must be represented by two (double) quote characters.

Notes:

Use of comma and double-quote in the column 1 is supported; however, the current version is not fully
tested for irregular use (such as multi repeated use of comma and double-quote combined together).

Figure 1-10 shows text-edited *.csv file that is the same file created in Excel file in the above example.

General

Rev 2015-08-13

1-9


http://en.wikipedia.org/wiki/Comma-separated_values#Toward_standardization

3DWhiffletree Version 1.4.0 User’'s Manual

Copyright © 2013-2014 Yoji Hosoe

Mj Galley_Example.csv - Motepad
File Edit Format View Help

[ & eSa)

Description,weight,x,Y,2
Structure,395.9995,606.9093,-79,.78729,243.
Ccart (Fwd-Inbd),150,600.8,-71,221.92

cart (Fwd-othd),150,600.8,-87.45,221.92
Cart (aAft-inbd),150,613.2,-71,221.92

cart (aft-othd),150,613.2,-87.45,221.92
refrigerator,110,618.47,-78.9,256.2
Glass Rack Lower (Content),15%,600.277,
Glass Rack upper (Content),15,600.277,-
Attendant Module,36,629.68,-68.6,267.87

4218

-74.6555,261. 884
74.6555,269. 87

-

Figure 1-10

1.5.5 *.col

Colors assigned to property IDs can be saved into *.col file. The file only contains property IDs and

associated Color IDs. One Color file can be shared with many FEM files, or many Color files can be used

with one FEM file whichever meets user’s working environment.

General Rev 2015-08-13
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2.0 OVERVIEW OF USER INTERFACE

The below screenshot shows 3DWhiffletree main widow.

File Information File Menu FEM Pane

\_/

Model Window

%I3[}Whilﬂeilee 1.0beta - [Galley_B‘mple.d] = [Gall%ple.wll]l

IEiIe View  Whiffletree ﬂelpl

FEM

S| PAp s =

Nodes | 2815 ||Hements | 2347

Whiffletree
ID |TESTSF Pull Direction +X
G-Factor 9.0 Split Wt Ratio  1.00

Other Factor |1.15,1.15

o e] ] ] T ] 22
A A A RN AR ;
PAE

X | 67857 ||y | 7B || Z | 2MM

MNavigati
avigation 4
. 30
Rotation (deg) 10
3
34 32 {L.-
17

\
L] &)

Left Mouse Button & Drag: Pan Nove z

Middle Mouse Button & Drag: Rolte
Mouse Wheel: Zoom In/Out
Shit + Left Mouse Button & Drag: Mygve Point
*

View Scale

116.2

\

\\ \ Certer X | 607.00 | |CenterY | -8255 | |CenterZ | 24193

\

Navigation Pane  Whiffletree Pane

Figure 2-1
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2.1 General

2.1.1 Window Size

The default window size, which is also the minimum window size, is 885 (W) x 720 (H) pixels with Model
Window size 598 (W) x 598 (H) pixels. You can maximize the window size, or adjust the window size by
dragging the right-bottom corner of the window. You can enlarge the window size to any size and the Model
Window size also changes at the same ratio. However, Model Window remains in square shape based on
the height of the window.

~ 885 (Min) e
“ %y 3DWhiffletree 1 Obeta - [Galley_Example.d] - [Galley_Example.wtr] ===
PRI o |
Nodes | 2813 ||Hements | 2347 - 598 (M|n) e =
(o) e =z
l+‘- mt. % "\ g
Sr] ¥ =2
‘TE.‘ES? v [z [z b “'—:"‘:‘#’1‘.’
20 | S
(vin) | e < =g -"\Hﬁﬁaﬂ&i#é’#i#&
EEBEE : T
f R .ln. . . '
BEOE A T cop
b*rv'!uI;:Eultjsii.PanMwe z '.EH.‘E (Mln)

Middle Mouse Button & Drag: Retate
Mouse Wheel: Zoom In/Out
Shit + Left Mouse Button & Drag: Move Point
X

Certter X | 607.00 | |CenterY | -8355 | |Certer Z | 24153 | | View Scale | 1162

W
Y (
Units [pixel]
Drag to change main window size

Figure 2-2

2.1.2 Tooltips

Tooltips are available for the most of icons by placing a mouse pointer over the icon and hold it for a second.
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Tooltip example

S sEhEs

N Cpen Mastran File (.d and .dat)

Figure 2-3

2.1.3 Click or Toggle Button

Icon buttons have two types: regular click button and toggle button. The way to see if the toggle button is
toggled or not is a color of the button as shown in the figure below. **

= I ENCEISIE =2
T— Toggle On

e (=] (] R=3
T— Toggle Off

L)

Figure 2-4
**|f your PC is set to “Classic Windows View” the toggle button actually “toggles”.

2.1.4 Locked or Unlocked Button

Some buttons are locked (grayed out) when their functions are unavailable. They become enabled
automatically when functions are available. Below figures show an example of enabled and locked button.

) 1[5 6 O 8 |

Button Enabled

FE'M\D\%%M\@H@HEEH@\

Button Locked

Figure 2-5

Overview of User Interface Rev 2015-08-13 2-3



3DWhiffletree Version 1.4.0 User’'s Manual Copyright © 2013-2014 Yoji Hosoe

2.1.5 Status Bar

Occasionally you will see messages in Status Bar at the left-bottom of the window. They are supportive
message for you to perform certain tasks. Figure below shows an example.

P L L s e 1 e
Mouge Wheel: Zoom InAOut N
Shit + Left Mouse Button & Drag: Mowve Poirt

Certer X | 60700 | |Center | -2255 | |CenterZ | 2

(_ Select and drag a point that you want to split.
\

\— Message example

Figure 2-6

2.2 File Information

At the very top of the window, you can see the followings:

e Software Version
e FEM File Name shown in the first square-bracket
e Whiffletree File Name shown in the second square-bracket

Whiffletree File Name
Software Version Displays [*.wtr] if no file is opened.

/—M /—M

[ %y 3DWhiffletree 1.1.0 - [Galley_Example.d] - [Galley_Exarnple.wtr]

H_/

FEM File Name
Displays [Blank Space] if no file is opened.

Figure 2-7
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2.3 File Menu

File Menu is available to perform tasks. Most tasks can be completed from Icons, but there are some
functions only available from File Menu. See corresponding sections for detail explanations of each menu.

Eile  View  Whiffletree  Help

L———» Displays help menu.

= Menus related to editing whiffletrees. (Section 5.0)

= Menus related to changing model views. (Section 4.0)

= Menus related to FEM file operations. (Section 3.0)

Figure 2-8

2.4 FEM Pane

FEM Pane is to perform tasks related to FEM file operation and also to change FEM model views. See
Section 3.0 for more details.

FEM
= RG] = =2
Modes g Bemerts G

Figure 2-9

2.5 Whiffletree Pane

Whiffletree Pane is to perform tasks related to Whiffletree constructions. See Section 5.0 for more details.
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ID |TESTIF Pull Direction =X
G-Factor 3.0 Split Wt Ratio
Other Factor |1.15, 1.15
== | hd
W

WTR
1

l.‘.-l.l'.I:A

&\

=Y
L " ]
¢ X

1-
'

&

+'Lr
S
3

[=x]

78

1=

7 IT 7854 I? 23454

Figure 2-10

2.6 Navigation Pane

Navigation Pane is to move, rotate, zoom, and change center location of models in Model Window. See
Section 4.0 for more details.

MNavigation

Rotation (deqg) ili] Zoom (%) 128
N e | =

TP F?:!,f <:ﬁ “o))

7
GHCICIE I\ HJ&\
I By ] &
Left Mouse Button & Drag: Pan Move

Middle Mouse Button & Drag: Rotate
Mouse Wheel: Zoom In/Out

Shit + Left Mouse Button & Drag: Move Point

Figure 2-11

2.7 Model Window

Model Window shows the following information.

e FEM Model
¢ Whiffletree Model
e Coordinate Axis

FEM model and Whiffletree model in Model Window they are simply overlapped view and do not act each
other.
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In addition, there are information boxes to show the following information.

Center X
Center Y
Center Z
View Scale

Center X, Y, and Z are model center. When you rotate the models, the models are rotated about the point.
The default model center is set to the geometric center of FEM model. The model center can be changed.

See Section 4.4 to adjust the model center.

View Scale is a factor related to zoomed size of the model. The larger View Scale is, the smaller the models
appear in the Model Window. The values depend on the model geometric size and view orientation and

users have no control on it.

Whiffletree Model —\ /7 FEM Model

e

Vi
1
1

E

Coordination Axis —— s”
H F
E
)
I Center X | 607.00 | |Center | -83.55 | |CenterZ | 241.93 lIVlew Scale | 1162 I
Center of Model / X View Scale
Figure 2-12

2-7
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3.0 FEM FILE AND MODEL VIEW

This section explains functions related to FEM file operations and FEM model views in 3DWhiffletree.

3.1 General

Functions are available through icon buttons and File Menu. You have more options to certain functions only
through File Menu.

3.1.1 FEM Pane

FEM Pane has icon buttons to access most of basic functions related to FEM file operations and model
views.

FEM

. i
FEM !I.:.EJM

BIFAGH (s R

Modes | 2815 || Elements | 22347

Figure 3-1

b

EEM Open FEM model file (Section 3.2)

=

Start in blank space (Section 3.4)

i

Save FEM model as a new file (Section 3.3)

-
m
=

Switch model view between Solid Color and Wire Mesh (Section 3.5)

Switch model view between Perpendicular View and Perspective View (Section 3.6)

Change element colors by element properties (Section 3.7)

Switch whiffletree views shown as Most-Front or With-FEM (Section 0)

o B o & |

Modes | 2815 Number of Nodes is displayed in FEM Pane. These numbers are actual
nodes used to show the FEM models and are NOT the number of nodes
contained in the original FEM file.

Similar to Nodes, actual number of elements used in 3DWhiffletree is
displayed.

Bemerts | 2347
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3.1.2 File Menu

File Menu associated with FEM file operations can be access from “File”. Menus associated with FEM
model views can be access from “View”. Some functions are not available through icon buttons in FEM

Pane.

Menus for FEM File Operations

File | View  Whiffletree  Help

File

Open FEM Model
Start in Blank Space

Reduce Mesh on Opening FEM

Read 10 Line Eelement
Read Solid Tet-Mesh

Save FEM Model

Exit

Recpen Current Model with Mesh Reduction

3.2 Open FEM Model File

Figure 3-2

Menus for Model View Operations

View | Whiffletree  Help

Wire Frame
Perspective View

Hide Behind (Points, Rods, and Beams)

Paxis 3
Adjust Model Center

Eelement Colors

Copy Image

The command to open FEM model file can be accessed from either icon in FEM Pane or File Menu as
shown in the figure below. Default folder that you see in File Open Dialog is the same folder where

3DWhiffletree.exe is stored.

& -

File

View  Whiffletree

Help

[ Open FEM Model
Start in Blank Space

Reduce Mesh on Opening FEM
Recpen Current Model with Mesh Reduction

Read 1D Line Eelement
Read Solid Tet-Mesh

Save FEM Model

Exit

Figure 3-3

FEM File and Model View
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3.2.1 Supported File Format and Limitation

3DWhiffletree can read FEM data files in any Nastran formats. The default file extensions to open are: *.d,
*.dat, *.blk, *bdf, *.nid, and *.nas. However, any file extensions can be used as long as the files are written in
plain text format (ASCII) and texts follow Nastran format.

Even though the file is written in Nastran format, certain restrictions will apply. See Section 1.5.1 for format
limitation.

Because 3DWhifletree does not rely on 3D engine or physical graphic board to display 3D model data,
number of nodes/elements directly affects the CPU usage of your machine, and thus, it affects the
performance of the software. You may feel slow responses if the FEM model has more than 5,000 elements
(of course it should depend on your machine). If your FEM model has large number of elements, for
example, nodes more than 10,000, it is recommended to coarse-mesh the model before open it in
3DWihiffletree, or use “Reduce Mesh” function explained in the following section.

3.2.2 Reduce Mesh

3DWhiffletree comes with a built-in function to reduce meshes (i.e., to reduce number of elements and
nodes). This can be done in 2 different ways: Before you open the FEM file, or After you open the FEM file.

Method A:

1. Before opening FEM file, select “Reduce Mesh on Opening” FEM in “File” Menu. You will see that the
option is checked. (Figure 3-4)

2. Open FEM file as normal.

File | View  Whiffletree Help
Open FEM Model
Start in Blank Space

# Reduce Mesh on Opening FEM

Recpen Current Model with Mesh Reduction

Read 10 Line Eelement
Read Solid Tet-Mesh

Save FEM Model

Exit

Figure 3-4

Method B:
1. Open FEM file first as normal.
2. Select “Reopen Current Model with Mesh Reduction”. (Figure 3-5)
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Help

Open FEM Model

File | View  Whiffletree

Start in Blank Space

Reduce Mesh on Opening FEM
I Recpen Current Model with Mesh Fleductionl

Read 10 Line Eelement
Read Solid Tet-Mesh

Save FEM Model

Exit

3DWhiffletree Version 1.4.0 User’'s Manual

Figure 3-5

Once the mesh reduction is successfully completed, you will see a message showing how much the

elements are reduced (Figure 3-6).

S AEELLVLRA ‘

RS
ﬁ AR
oy

ov&w ...... il

(IRREAE suLY

AL LLES

Q@
S
S
¢
X

L

L

ADWhiffletree

Elements reduced from 4435 to 1828,

Figure 3-6

Logics Behind:

3-4
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Mesh reductions are performed by merging 4 of CQUAD4 elements into one CQUAD4 element. All mid-
notes will be removed. The mesh reduction takes place only if the mid-center node (a node shared among 4
elements) is connected with 4 of CQUAD4 elements. If there are more than 4 elements or there is
CTETRAS elements, then these elements will not be merged.

1 element
(mesh reduced)

|

More than 4 elements or No mesh reduction

containing triangular elements
g,

Y

4 rectangular elements

Figure 3-7

Warnings and Precautions:

1. Merged Joints

When you are proceeding with mesh reductions by either Method A or Method B above, you will see the
following warning message.

IDWhiffletree ==

-

Make sure nodes are not shared between different paneles,

OK

Figure 3-8

This is because 3DWhiffletree cannot distinguish out-of-plane nodes.
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This could result in
such mesh reductions

Shared nodes between two planes

Figure 3-9

2. Re-Opening the Re-Opened File

It is known that error will occur when you try to use “Reopen Current Model with Mesh Reduction” when
the model is already open with mesh reduction. Therefore, the command becomes unavailable once
you reopen the model. However, it is possible to further reduce elements. To do so, save the reopened
model first, open the saved model, and then, use “Reopen Current Model with Mesh Reduction” again.

Refer to Section 3.3 for how to save model.

When you reach a point that no more reduction is possible, you will see the following message.

3DWhiffletree ==

-

Mo more reduction of elerments were possible.

Figure 3-10

3. Distorted Element

It is also known that some of elements are distorted after mesh reduction. This is due to mesh-reduction
algorithm. Example is shown in the figure below. As FEM model is just for a supportive view to construct
whiffletrees, the mesh quality will not affect the actual whiffletree constructions.
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Figure 3-11

Merged Element and Property:

When 4 of CQUAD4 elements are merged into 1 of CQUAD4 element, original elements are deleted and a
new element is created with an element property ID set to zero. If you open Element Property Color window
(Section 3.7), you can see Property ID = 0, which ID means merged element.

BElement Property [D:

Define Elernent Property Color

-

=

Preview

# 0
4014
4024
6014

6024

Define Color | | White Al |

[ ok ][ canca |

Figure 3-12

Using Element Property Color window, you can set a color for merged element (Element Property ID = 0).
Figure below shows FEM model with merged element color set to gray.

FEM File and Model View
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Figure 3-13

3.2.3 Read 1D Line Element

1D line elements can be displayed if the following option is checked when opening the FEM model. By
default, this option is turned off.

File | View  Whiffletree Help
Open FEM Model
Start in Blank Space

Reduce Mesh on Opening FEM

Reocpen Current Model with Mesh Reduction

# Read 1D Line Eelemnent

Read Solid Tet-Mesh
Save FEM Model

Exit

Figure 3-14
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Model with Line Elements
Figure 3-15

Types of 1D elements allowed to be used are defined in 3DWTSystem.ini file. Only the most common line
elements (CBAR, CBEAM, CROD) are defined by default; however, it is possible for users to add more
elements in the 3DWTSystem.ini file. Additional allowed element types are CBEND, CONROD, CTUBE, and
CVISC.

fElement Types (Add more elements separated by
$s071id Element is CTETRA only.
4NDdeQuc:1dE'I ement 1 CoUADd

[ ZrodeLineE lement: CBAR, CBEAM, CROD |
sol1delemnt: CTETRA
. \ _________________________
Add more line elements as necessary, separated by comma.

Figure 3-16

Remarks for Displaying 1D line elements:

1. 1D line elements are always shown in black color when displayed. There is not option to change the line
element colors.

2. Even though some elements look like line elements such as CELAS2 (scalar elements) or RBE2 (R-
type elements), they will NOT be displayed even though you add the element types in 3DWTSystem.ini
file. This is because the Nastran Bulk data formats are different for these elements.

3. ltis a known issue that FEM model may be crashed when reading 1D element at the same time the
option of reducing meshes is turned on. If you attempt to read 1D element with reducing meshes, the
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following warning message will be displayed. Click Cancel to just open the FEM model without reducing
meshes (still reads 1D element).

3DWhiffletree ==

-

Reducing meshes at the same tirne reading bar elements may crash the model.

Click OK to continue or Cancel to abort reducing meshes,

oK ] ’ Cancel

Figure 3-17

3.2.4 Read Solid Tet-Mesh

Solid tetra mesh can be displayed if the following option is checked when opening the FEM model. By
default, this option is turned on.

When opening the model, tetra meshes are converted into CTETRA3 elements only for outer surfaces.
Because of this conversion process, it will take longer time to open the file.
File | View  Whiffletree  Help

Open FEM Model

Start in Blank Space

Reduce Mesh on Opening FEM

Reopen Current Model with Mesh Reduction

Read 10 Line Eelement

f— Read Solid Tet-Mesh

Save FEM Model

Exit

Figure 3-18
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Figure 3-19

3.3 Save File

The command to save FEM model file can be accessed from either icon in FEM Pane or File Menu as
shown in the figure below.

‘ 1 File | View  Whiffletree Help
e or
FEM Open FEM Model

Start in Blank Space

Reduce Mesh on Opening FEM
Recpen Current Model with Mesh Reduction

Read 1D Line Eelement
Read Solid Tet-Mesh

Save FEM Model

Exit

Figure 3-20

When saving the file, the following messages will pop up. It is to confirm whether you want to include “E” in
the scientific format. If you click Yes, “E” will be included in the scientific format, otherwise, “E” will be

omitted.
Example:
Original values: -1.234E-6 1.2345E+6
Click Yes to use “E™: -1.23E-6 1.235E+6
Click No not to use “E™: -1.234-6 1.2345+6
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As explained in Section 1.5.1, 3DWhiffletre can read both format with or without a symbol “E” as regular
Nastran does. Since the saved file can only be used in 3DWhiffletree.exe, it does not matter which format
you take. However, if you want to use the values imported to other software, such as Microsoft Excel, then
scientific format without a symbol “E” may not work.

ADWhiffletree £3

Do you want to use "E" when scientific formrat is required?
Example: -1.23E-6 instead of -1.234-6

Click Yes === -1.23E-6
Click Mo ==> -1.234-6

Motes:

1. Scientific format will be used only when it is required.

2. Mastran can take either format, but Excel won't take values without "E".

3. Mot using "E" can allow one more significant digits (one more decimal places),

es l | Mo

Figure 3-21

Followings are some remarks that you may want to know.
a) Default folder that you see in File Save Dialog is the same folder where 3DWhiffletree.exe is stored.
b) File extension of the saved file is “.d".

c) Default file name is “XXX-Copy.d” where XXX is the original file name, but you can change it when
you saving. (So, technically you can consider it as “Save As” function.)

d) The saved data created by 3DWhiffletree only contains model data that is displayed. All other data
such as Nastran executive control data or any element data that are not displayed will not be saved.
For example, if your model does not show 1D line element (See Section 3.2.3), the 1D element data
will be removed from the saved file. Further, element and grid numberings may be different from the
original Nastran data file.

e) Even though 3DWhiffletree.exe can read Large-Field format and Free-Field format (See Sec 1.5.1),
saving FEM data is currently available only in Small-Field format.

Cautions:

Saved file shall be used by 3DWhiffletree.exe only. It does not guarantee any use for commercial FEM
pre/post processors or solvers.

Example Use of the “Save” Function

1. You used mesh reduction (Section 3.2.2). If you want to further reduce the model, you need to save
the reduced mesh model first, then open the file to reduce mesh again.

FEM File and Model View Rev 2015-08-13 3-12



3DWhiffletree Version 1.4.0 User’'s Manual Copyright © 2013-2014 Yoji Hosoe

2. You used mesh reduction (Section 3.2.2). You don’t want to reduce the mesh every time you open
the same model so you want save the reduced mesh model.

3. You have a large model file but most of contents are non-relevant data for just FEM view purpose

such as DMIG entries. You want to compact the file only to contain the necessary data to be used in
3DWhiffletree.

3.4  Startin Blank Space

When launched, 3DWhiffletree starts with an initial blank screen with 3 main axes (X, Y, and Z) as shown in
the Figure below.

-

v

Center X | 0.00 CenterY | 0.00 CenterZ | 0.00 Wiew Scale

Figure 3-22

This initial screen can be brought at any time by either clicking an icon or from File Menu. If there are any
unsaved whiffletree data, you'll be asked if you want to save. Use of this function (Start in Blank Space)
actually does the almost same thing that you close the application and start it again.
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‘ File | View Whiffletree Help
or
Open FEM Model

Start in Blank Space

Reduce Mesh on Opening FEM
Recpen Current Model with Mesh Reduction

Read 1D Line Eelement
Read Solid Tet-Mesh

Save FEM Model

Exit

Figure 3-23

35 Wire Frame View

Wire Frame View can be turned on and off from the following icon or File Menu.

‘ or  File [View | Whiffletree  Help
|WireFrame

Perspective View

Hide Behind (Points, Rods, and Bearns)

Auxis 3
Adjust Model Center

Eelement Colors

Copy Image

Figure 3-24
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Wire Frame Off | Wire Frame On

Figure 3-25

3.6 Perspective View

Perspective View can be turned on and off from the following icon or File Menu.

‘ or  File [ View | Whiffletree  Help

Wire Frame

I Perspective View I

Hide Behind (Points, Rods, and Beamns)

Paxis 3
Adjust Model Center

Eelement Colors

Copy Image

Figure 3-26
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Perspective View On
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Perspective View Off ‘ ij’
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Figure 3-27

Change Element Color

3.7

Element colors can be changed from the following icon or File Menu.

Help

Wire Frame

Perspective View

Hide Behind (Points, Rods, and Beams)

Axis

Adjust Model Center

IEEIement Colors

Copy Image

File | View | Whiffletree

or

&

Figure 3-28

Remarks:

1. Separate element property IDs are required for separate colors.

2. No colors can be assigned for 1D line element.

3. Assigned colors cannot be saved even though you use Save FEM function (Section 3.3). The initial

default color is always Powder Blue when you load FEM model.

4. Customized color is available as shown in the figure below.

3-16
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/—@ Select Element Property ID

’Deﬁne Element Propérty Celor - [*.col]
BElement Property/AD: Preview ‘//
4014 L4
4024
BO0T2
6024 ~

Define Color || | White Al |
| Random Al | | ResetAl | l_’\:
:
COoL
[ ok || Caneel |

Click “Define Custom Colors” if you want to
Customize colors.

/—@ Click “Define Color” or preview color

Color

Basic

o
(78
=1
3
=}

mink

colors:

EEEE T

171fF EEEERT
1717 HEEERN
171 HEEERNT
171 FEENEN
1777 EEEEEE

171

-

171 TTHEEEN H

Define Custom Colors =

i

oK

s ] [t

O—|
7

P P

Ay,
oA
Vi

P
s

T

A

A
(T T

Color [E3s]
Basic colors:
ey el § 8| ‘
HMrTFENENN
ERNEEENNEN
ENEEEEEN
EEEEEEEN
EEEENETE
Custom colors:
mrrrrrorr _ _
ol wl el ol el P
Sat: 190 Green: 162 E:>
Define Custom Colors > ColoriSglid ) m: 159 Blue: 183
Il ok [ cancel |[ hHep | | Add to Custom Colors ]
L@ Click OK
Figure 3-29
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Assign Random Colors

If you want to assign colors all at once, use “Random All” button. Random colors will be assigned to each
property.

Define Element Property Color - [*.col] @
Blement Property 10: Preview
1280
1281
1282
1250
1291 Define Color | | White Al |
1252
1293
e Random All || Resetal |
1295
1296 =
1297
ok || Cancal |

Figure 3-30
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Save/Open Color Setting

1. User can save color settings associated with element property IDs.

2. By opening saved color file (*.col), element colors are automatically assigned per previously set colors
per element property ID.

3. If element property ID are not found in the previously saved color file, the color will not change in that
property ID (but all other property ID found in the file will change).

4. User can save as many color files as user want to meet user’s work environment.

-

Define Element Property Color - [*.col] @

Element Property [D: Preview

1280
1281
1282
1250

1291 | Define Color | | White Al |
1292

1293

15 | Random All | | ResetAl |
1295
1296
1297

Open color file (*.col) to assign user-preset colors —/

Save user-set colors into color file (*.col).

Figure 3-31

FEM File and Model View Rev 2015-08-13 3-19



Copyright © 2013-2014 Yoji Hosoe

3DWhiffletree Version 1.4.0 User’'s Manual

Hide-Behind View
Hide-Behind View is to hide points, rods, and beams behind the FEM model if they are actually behind of it.

The view can be turned on and off by the following icon or File Menu.

3.8

Whiffletree  Help

‘ or  File [View
Wire Frame

Perspective View
Hide Behind (Points, Rods, and Beams)|

Axis
Adjust Model Center

Eelement Colors

Copy Image

Figure 3-32

Remarks:
Turning on the Hide-Behind View makes it easier to visualize whiffletrees.

The view can only be turned on when there is at least one loading point.
By turning on the view, each rod and beam in the whiffletrees are divided into 20 elements.

Therefore, turning on this view makes the model heavy and you may feel slower responses if there

Hid-Behind View On

1.
2.
3

are many rods and beams in your whiffletrees.

Hid-Behind View Off ‘

i,

7 B

//”//ltw Ly,
2

A

St

"‘i'l""iz-"’. ey
% 2 gﬁ’f‘,‘r— et ] PLIET) g%’l{ﬁ'ﬂ H
g < im.m.'ﬁll. g
=%m.. H ; ﬁ%lﬂ.ﬁnﬂ
. RSN . E )
< S % N S
] HS ]

N
Ea]
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Figure 3-33
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4.0 NAVIATION OF MODEL

This section explains functions related to FEM and whiffletree model navigation.

4.1 General

Functions are available through icon buttons and File Menu. Most of view operations (move, zoom, or rotate
model) have mouse shortcut.

4.1.1 Navigation Pane

Navigation Pane has icon buttons to access most of basic functions related to FEM and whiffletree model

navigations.
Mavigation
Rotation (deg) 10 Zoom (%) 125
=\ - el ._‘..-':: _.';-‘ H ':;';' ) H lﬁ‘
00 s
¥ z Z Z vy
x| x| x| K
Figure 4-1
Rotation {deg) 10 Angle of rotation achieved by one click on related icons or mouse move.
' The initial value is set between 2 to 16 degrees depending on number of
elements and CPU speed, but it can be changed by typing the desired
values in the box.
Zoom (%) 125 Percentage of zooming in/out of the model with respect to the current

view size, achieved by one click on related icons or mouse scroll move.
The default value is set to 12.5 percent but it can be changed by typing
the desired values in the box.

Rotate model down (Section 4.2.1)
Shortcut: Middle Mouse Button + Drag Down [Inside Circle]

. Rotate model up (Section 4.2.1)
& Shortcut: Middle Mouse Button + Drag Up [Inside Circle]

7= Rotate model right (Section 4.2.1)
Shortcut: Middle Mouse Button + Drag Right [Inside Circle]

=%  Rotate model left (Section 4.2.1)
Shortcut: Middle Mouse Button + Drag Left [Inside Circle]

Rotate model clockwise (Section 4.2.1)
Shortcut: Middle Mouse Button + Drag [Outside Circle]
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Rotate model counterclockwise (Section 4.2.1)
Shortcut: Middle Mouse Button + Drag [Outside Circle]

Pan move left model (Section 4.2.2)
Shortcut: Left Mouse Button + Drag

Pan move up model (Section 4.2.2)
Shortcut: Left Mouse Button + Drag

Pan move down model (Section 4.2.2)
Shortcut: Left Mouse Button + Drag

Pan move right model (Section 4.2.2)
Shortcut: Left Mouse Button + Drag

Zoom in model (Section 4.2.3)
Shortcut: Mouse Scroll Back

Zoom in model (Section 4.2.3)
Shortcut: Mouse Scroll Forward

Change model view into XY plane (Section 4.2.4)

Change model view into YZ plane (Section 4.2.4)

Change model view into XZ plane (Section 4.2.4)

Change model view into Isometric (Section 4.2.4)

Copy model image into clipboard (Section 4.5)

Adjust model center (Section 4.4)

There is basically no File Menu associated with model view operations such as move, zoom, or rotate
models. There are some functions available from File Menu. The Axis option is only available from File

Menu.

Naviation of Model
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File | View | Whiffletree Help

Wire Frame

Perspective View

Hide Behind (Points, Rods, and Beams)

Axis 3
Adjust Model Center

Eelerment Colors

Copy Image

Figure 4-2

4.2 Model View Operation

There are four types of model view operations. Following subsections describe detail of each operation.

e Rotate
e Pan Move
e Zoom
e Preset View
4.2.1 Rotate
By Icon
Rotation (deg) 10 = Angle of rotate by one click or mouse move
(Can be edited)
M (| e m I_I ‘-" \-:1
|—> Rotate counter-clockwise
Rotate clockwise
= Rotate Left
= Rotate Right
= Rotate Up
= Rotate Down
Figure 4-3
By Mouse
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Dragging cursor by middle mouse button in the Model Window can rotate the model. When you try to rotate,
a red-dotted circle will appear in the Model Window. Dragging inside the circle will rotate the model around
vertical or horizontal axis. Dragging outside the circle will rotate the model around the axis perpendicular to

the screen.
= 7 —
f J’j!;“ Hp |
e, i
(o v
el
] itz
; i
gllia
\ . ‘5’-';15%
S
Rotate Left — Right Rotate Up — Down Rotate Clock — Counterclockwise
Figure 4-4
Remarks:

1. By default, the center of rotation is set to the geometric center of FEM. It is NOT the center of view
window. The center of rotation can be changed by using Adjust Model Center function (Section 4.4).

2. If your model rotate too fast by mouse (usually happens when model size is small in terms of number of
nodes/elements), lower the “Rotation (deg)” in the box.

Rotation (deqg) 10

'}

Adjust angle to change rotation speed by mouse

Figure 4-5

4.2.2 Pan Move

By Icon

Naviation of Model Rev 2015-08-13 4-4
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clo/o|o|

| = Pan-move Right

=  Pan-move Down

= Pan-move Up

=  Pan-move Left

Figure 4-6

By Mouse

Dragging left mouse button in the Model Window can pan-move the model.

Remarks:

Moving model does NOT shift the model center for zoom in/out. The model center can be changed by using
Adjust Model Center function (Section 4.4).

4.2.3 Zoom In and Out

By Icon

Zoom (%) 125 = Percentage of zoom by one click or one
mouse scroll move with respect to the current

= zoom.
ML (Can be edited)

= Zoom Out

= 7Zoom In

Figure 4-7

By Mouse (Scroll)
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Zoom In (Scroll Back)

Zoom Out (Scroll Forward)

Figure 4-8

Remarks:

By default, the center of zoom in/out is set to the geometric center of FEM. It is NOT the center of view
window. The center of zoom in/out can be changed by using Adjust Model Center function (Section 4.4).

4.2.4 Preset View Angle

There are four types of preset view: XY Plane, YZ Plane, XZ Plane, and Isometric View. All of them can be
accessed only from icons. Whenever preset view is selected, the zoom level is automatically adjusted to fit
in Model Window. The default is Isometric view when opening a new FEM model (not whiffletree model).

af &
|

Z
Y

x|y

= |Isometric View (Default when open new FEM )

= XZ Plane

= YZ Plane

= XY Plane

Figure 4-9
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s Z
Isometric View k‘x

z z

L. L.

. z i z
YZ Plane View XZ Plane View

Figure 4-10

4.3 Coordination Axis

By default, global coordinate axis is shown at the lower left corner in the model view window. Axis properties
can be changed only from File Menu, View >> Axis.
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File | View | Whiffletree  Help

Wire Frame
Perspective View

Hide Behind (Points, Rods, and Beams)

Axis

2

Adjust Model Center

Eelement Colors

Copy Image

Global Coordinate System
Airplane Coordinate System

Custom Coordinate System

Figure 4-11

4.3.1 Turn On and Off the Axis

Axis can be turned on by selecting unchecked coordinate system from File Menu. Re-selecting checked
coordinate system again will uncheck and turn off the axis view.

Global Coordinate System
Airplane Coordinate System

Custom Coordinate System

Checked (Turned On)

Figure 4-12

4.3.2 Global Coordinate System

Global Coordinate System

Airplane Coordinate System

Custom Coordinate Systemn

Unchecked (Turned Off)

Global coordinate system is a default coordinate system. It shows X-Y-Z axis corresponding to FEM model

axis.

# Global Coordinate System

Airplane Coordinate System

Custom Coordinate System

Figure 4-13

4.3.3 Airplane Coordinate System
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Airplane coordinate system can be shown as FWD, RHS, and UP.

Global Coordinate System Up
) ) FWD
# Airplane Coordinate System E\T/;_HS
Custom Coordinate System
Figure 4-14

Remarks:

The default airplane coordinate system is set as follows.

FWD = -X
RHS = +Y
UP = +Z

This default can be changed in 3DWhiffletree.ini file by changing the following line. Currently, FWD can be
only changed to either “+X” or “-X", RHS to “+Y” or “-Y”, and UP to “+Z” or “-Z". Assigning other values will
cause errors.

Also note that only FWD, RHS, and UP can be used for airplane coordination. For example, AFT, LHS or
DOWN cannot be used.

fpafault Airplane Coordinate

AirplaneCoordinate: [FWD=-X, RH5=+Y, UP=+Z |
oo ooy

Change signs to set default axis.

Figure 4-15

4.3.4 Custom Coordinate System

Custom Coordinate System can allow you to specify your own axis for airplane coordinate system. Currently
following axis can be set to FWD, RHS, and UP.

FWD = +X or -X
RHS = +Y or -Y
UP = +Z or -Z

Naviation of Model Rev 2015-08-13 4-9
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Global Coordinate System Define Airplane Coordinate System [E3]

Airplane Coordinate System

# Custom Coordinate Systemn Fual 2 b

RHS =Y

I

UP =7 - OK

Figure 4-16

Remarks:

This customized coordinate system is effective only for the current window and will not be saved.

4.4  Adjust Model Center

Center of model is displayed just below the Model Window. The model center is a base point for zooming
in/out the model as well as rotating the model. When FEM file is opened, the model center is calculated
based on the FEM model geometry. Then, the geometric center is set to the model center.

I n

Certer ¥ | 0.00 Center Y | 0.00 Center Z 3

00 View Scale 2.00

[

Figure 4-17

The model center can be adjusted from the following icon or File Menu.

’@‘ or File | View | Whiffletree Help

Wire Frame

Perspective View

Hide Behind (Points, Rods, and Beams)

Ais 3
Adjust Model Center I

Eelement Colors

Copy Image

Figure 4-18

There are four types of center you can select. Each property is explained in the table below.

FEM Geometric Center
Loading Points Overall CG
Current Window Center
Custom
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-

Adjust Model Center @

@ FEM Geometric Center
X &07.00 Y -33.55 il 241.93

Loading Points Cverall CG

(=]
(4]
I
Pl
L% )
I
(4=
I

vvvvvv

539 55 76.14

Pl
(]
(5]
[=r]
(]

Custom

T
]
1
5
3
(=]
(5}
[y}
Ln
Pl
I
=1
(4=
[ %)

0K || cencel

Mote: The cument view will be reset to lsametric View.

Figure 4-19

Table 4-1

Option Button Model Center

FEM Geometric Center . y.2) = (xMaX ~ Xy Yaax = Yuin Zuax —ZMmJ
) ’ 2

2 2

Loading Points Overall CG

(X, Z):(Zmi-xi 2m -y, Zmi-ziJ

Xm o ¥Ym ' ¥m
To select this option, there must be at least one loading
point in the current model.

Current Window Center Current window center will be automatically extracted.

Custom Any numbers can be typed in.

Once new model center is selected, the model will be regenerated to be fit in Model Window with Isometric
View.

4.5 Copy Image

Copy Image function can be accessed from the following icon or File Menu. This will capture a bitmap image
of Model Window. The copied image will be stored into clipboard so that it can be pasted to other application.
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8i or File | View | Whiffletree Help

Wire Frame

Perspective View

Hide Behind (Points, Rods, and Beams)

Axiz »
Adjust Model Center

Eelement Colors

Copy Image
Figure 4-20
Warnings:
1. As of Version 1.0, this Copy Image function from File Menu is disabled.

2. This function is almost same as PC'’s Print Screen function. Therefore, the Model Window must be

cleared and entire window should be seen in your screen to capture correct images. Otherwise, loss of
image will happen.
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5.0 WHIFFLETREE CONSTRUCTION

This section explains functions related to construction of whiffletree which is a core part of this software.

5.1 General

Functions are available through icon buttons and File Menu. You have more options to certain functions only
through File Menu.

5.1.1 General Model View and Nomenclature

Below figures show an example view of building whiffletrees. Whiffletrees generally consist of CG points,
Rods, Beams, and Connecting Points. Nomenclatures of these components are explained in the table below.

ﬁlh _

Connecting Points

CG Points
(Loading Points)

Rod

Figure 5-1
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Nomenclature

CG

Beam (*1)

Rod (*2)

Connecting Point

(Numbers)

Appearance

in Model
Red Dot

Green Line

Blue Line

Blue dot

Numbers

Table 5-1

Meanings

It is also called “Loading Point”. The point represents weight
components where loads are applied. CG points have the
following properties:

e Can be only connected by rod.

e CG properties (weight, location, and name) can be
edited at any time.

e Can be split.

e Can be moved together with another CG in the plane
perpendicular to the loading direction while keeping the
overall CG same.

e Can be moved in the plane perpendicular to the loading
direction (overall CG will change.)

e Can be added at any time.

e Can be deleted only when not connected to the other
point.

This is moment arm. It connects with two rods at both ends
and with one rod at somewhere in between. Beam has the
following properties:

e Must contain 3 connecting points.

¢ Must be perpendicular to the loading direction.

This is axially loaded device. It connects between two
connecting points (one end can be CG). Rod has the
following properties:

e Must contain 2 points at ends.

e Must be parallel to the loading direction.

This is a connecting point between rod and beam. It has the
following properties:
e Must be connected with beam except for the top of
whiffletree.
e Can be moved in rod’s axial direction.
e Can be deleted if it is at the top of whiffletrees.
¢ All 3 points within the same beam will move together.

Numbers are automatically assigned at CG (Loading Points)
and Connecting Points. Numbers are not fixed and can be
changed automatically at any time if construction changes
but cannot be edited by users.

Notes:

*1) Even though it is called “Beam”, the physical constructions do not need to be actually a beam.
*2) Even though it is called “Rod”, the physical constructions do not need to be actually a rod.

5.1.2 Whiffletree Pane

Whiffletree Pane has icon buttons to access most of basic functions related to whiffletree constructions.

Whiffletree Construction
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ID |TESTSF

Pull Direction +

(4=
[

53-Factor

Split Wt Ratio  1.00

Cther Factor [1.15, 1.15

3

.
[

5

Whiffletree

ID | TESTSF Pull Direction +X

G-Factor 9.0 Split Wt Ratio  1.00

Other Facter |1.15, 1.15

= 1 =l | = _ 2

wrn | W) e [Z IH N || &ria

+ 7 [ LEL

(4 m(... (¥ “I'\A JL(|EY 29\
X i £
Figure 5-2
ID can be assigned to an individual whiffletree model.
It can be assigned or changed in Whiffletree Edit
Window. See Section 6.2 for more detail.
Pull Direction shows a loading direction. It can be set
or modified in Whiffletree Edit Window. See Section
6.4for more detail.
G-Factor is a loading factor multiplied to the original
weight at each CG Point. It can be set or modified in
Whiffletree Edit Window. See Section 6.5 for more
detail.
This is a weight ratio to be used when splitting a CG
into to. It can be directly modified. See Section 5.14.3
for more detail about splitting a CG point.
Other Factor is any additional factors multiplied
together with G-Factor. You can enter as many factors
as you want. It can be edited in Whiffletree Edit
Window. See Section 6.6 for more detail.
7 This shows supplemental information about the

location of point. It can be displayed when you are
modifying a point.

Open whiffletree (*.wtr) file (Section 5.2)
Save whiffletree (*.wtr) file (Section 5.3)
| Openandread CG (*.csv) file (Section 5.4)

/1| View and edit whiffletree data (Section 5.5)
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View and edit whiffletree material data (Section 5.6)

View whiffletree diagram (Section 5.7)

| H

75 | Export whiffletree to CATIA (Section 5.8)
Create a whiffletree between two points (Section 5.9)

Delete all whiffletrees (Section 5.10)

Delete a point (Section 5.12)

Obtain information of a point (Section 5.13)

Move a point along loading direction (Section 5.14)

'|'L Add a CG point (Section 5.11)
ML
?
"
L‘R Shortcut: SHIFT KEY + Mouse Left Button Drag

:"’1 Split a CG point (Section 5.14.3)

+%| Move two CG points together (Section 5.14.4)

& Move a CG point in a plane perpendicular to loading direction (Section 5.14.5)

5.1.3 File Menu

Most of File Menu is available in icons, but there are some functions only available from File Menu such as
changing graphic size of rod/beam/point and turning on/off the warning for whiffletree beam length.
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5.2 Open Whiffletree File (*.wtr)

File

View | Whiffletree | Help

Open File

Save File
Open CG Data

Add Point

Delete Point

Show Point Info

Mowe Point (In Pull Direction)
Mawve Tweo Points

Mowve Point (In-Plane)

Split Point (CE)

Build Whiffletree
Delete All Whiffletree

View ar Edit Point

Change Point Size
Change Rod Size

Change Bearn Size
View or Edit Material

Whiffletree Diagram
Export to Catia
Mo Bearn Length Warning

Figure 5-3

Previously saved whiffletree data (*.wtr file) can be opened from the following icon or File Menu.

WTR

or

File

What is Whiffletree Data (*.wtr) File?

View | Whiffletree | Help

Save File

Open CG Data

Figure 5-4

-_—
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Whiffletree data file is a text-formatted file containing whiffletree geometry data as well as other
associated information to the whiffletree model. It is used to save your whiffletree created in
3DWhiffletree program to be used for later time. Even though the file is written in ASCII-format, it is not
intended to be edited by text editors. The contents have to be written in specific format and order. The
default file extension is (*.wtr); however, any file extensions can be opened as long as it is written in text

format.
| 561_AFT.wir - Notepad = |
File Edit Format View Help
1D: -
Case Description:
Pull Direction: +X
Load Factor: 1.0
other Factor: 1.0
Catia: 0,0,0,+X,+Y,+Z,1.0,1
units: L=in, w=1h, M=in-1b
Display Decimals: L=0.00; wW=#,###; M=#, ###; Iyy=0.000; c=0.000; Ftu=0 =
warning Length: 2.0
Description, weight, X, ¥, Z, Picturex, Picturey, Picturez, PointType Load, Length
"Structure - Upper—otbd" ”438.3225' 606 a1" ”—73 19" 251 42 " 635. 846958254943
"structure - Upper-inbd", "438. 3225 "606. 91 "-86. 39 251.42"," 558. 676228660059
"Refrigerator”,'¢8?.025 618 37", —80 39 , 256.86 ,' 582 393036045099 " 4286, 381121
"Glass Rack Lower (Content) "66. 4125 ,'600.28","-74.66", 261 88" 89 .766832194605
"Glass Rack Upper-Upper (content) "33, 25',“600.28 ,“—74 66", 273877 ," 739.0594640¢
"Glass Rack Upper-Lower (Content)™, 33.25','600.28 ,'-74.66","265.87"," 706.1703018¢
"attendant Module"”,"159.39","629.68","-68.6","267. 87” " 663 300243127423 ' 326.575:z
"cart (Fwd-0thd-Inbd)","332.0625","600.8", ”—84 45" 221 92"," 466. 720210512312”,” 7C
‘cart (Fwd—otbd—otbd)",”332.0625” ”600.8” —90 45" 221 92"," 431.642606151001"," 6¢
"Cart (aft-otbd-upper)”,"332.0625","613.2" —84 45 "231. 92 ," 471.339926956049"," ¢
"cart (aft-Inbd-upper)","332. 0625" "613. 2” " 231 92"," 567.511025579975"," 615
‘cart (Fwd—Inbd—InEd)”,'332 0625","600.8" " "," 562.891309136238"," 733.¢
"cart (Fwd—Inbd—Otbd)”,'332.0625 600 8" 74", .92"," 527.813704774928"," 724.1
‘cart (Aft—Inbd—Lower)”,”332.0625 "gl3. 2 —74", 211.92"," 450.21051567353"," 721.4
"cart (aft-otbd-Lower)","332.0625","613.2","-90.45","211.92"," 354.039417049604"," €
"structure - Lower-othd","438.3225","606.91","-83.09","235.42"," 512.190586622673",
"Structure - Lower-inbd","438.3225","606.91","-76.49","235.42"," 550.775951420115",
"rRod: from 1",""," 649,38238855788","-73,19"," 251.42"," 510.8557320848"," 318.14714
“"rod: from 2",""," 649.38238855?88" "-8§6.39"," 251.42"," 433.685002489917"," 296.92°¢
"Beam: between 18 & 19",""," 649. 38238855788 ,'=79.79"," 251.42"," 472.270367287358
"rRod: from 20",""," 682. 924479687945” "-79. 79” " 251.42"," 373.559952332849"," 143.¢
"rod: from 5",""," 640.012504305786","-74.66" ” 273.87"," ©22.13139384223"," 231.78:
"rRod: from &",""," 640.012504305786","-74.66" ," 265.87"," 589,242231624176"," 277.9¢ ~
Fl nm 3
Figure 5-5
Remarks:

1. Default file extension in File Open Dialog is (*.wtr).

2. Opening whiffletree models does not automatically readjust the center of model based on the whiffletree
geometry or its overall CG. This is because FEM model is usually opened first and whiffletree model will
be constructed based on the FEM model space. If you open whiffletree model only, you may need to
adjust model center to view your whiffletree models (See Section 4.4).

5.3 Save Whiffletree File (*.wtr)

You can save your whiffletree data for later use. Saving whiffletree data can be done from the following icon
or File Menu. Table 5-2 summarizes what you can save and what you can NOT save in the *.wtr file.
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Id or File View | Whiffletree | Help
WTR .
Open File
Open CG Data
R —— e
Figure 5-6
Table 5-2
What you can save What you can NOT save

e Whiffletree ID e Relationship between FEM model.
e Case Description Remember FEM model is just an
e Pull Direction image to help whiffletree
e Load Factor constructions and there is no
e Other Factor(s) interaction with whiffletree models.
e Whiffletree Constructions including e Whiffletree Model View Properties

CG, Loads, Rod, and Beam including Rotation Angle, View
e Origin for CATIA export Angle, Location, and Zoom Level
e Coordinate for CATIA export  Point Size
e Scale Factor for CATIA export * Rod Size
e Scale Conversion for CATIA export * Beam Size _
¢ Whiffletree Display Units (L, W, M) e Whiffletree Material (You can save
« Display Format them in a separate *.mtl file — See

(L, W, M, lyy, ¢, and Ftu for Section 7.0)
Whiffletree, but not for Material. You
can save them in a separate *.mtl
file — See Section 7.0)
e Warning Length

Remarks:

1. Default file extension in Save File Dialog is (*.wtr).

2. Icon and File Menu can become active only when changes are made in whiffletree data.

3. You can change/edit file name before you confirm to save. Therefore, this function is technically

considered as “Save As” function.

5.4 Read CG Data

CG data file (*.csv) can be read through the following icon or File Menu.
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= or File  View | Whiffletree | Help

Open File

Save File

Open CG Data
R ———

Figure 5-7

What is CG data?

CG data is a set of point data where loads will be applied by whiffletree. The CG Points are located very
bottom of the whiffletree, and therefore, it shows distribution of loads. The CG Points can be created in
3DWhiffletree by Add Point command (Section 5.11). However, it is more common and efficient to create
CG points separately from 3DWhiffletree and let the program read the points. This is because users usually
have a set of CG data already if the users already have FEM model.

How the CG data file (.csv) can be created?

There is no function to save points as CG data file in 3DWhiffletree program. You need to create CG data
file by yourself. Since the file is in CSV format (comma-separated values), you can use any commercial
software such as Microsoft Excel to edit and save the file in CSV format. Refer to Section 1.5.4 for how to
create CSV file.

Difference between CG data file (*.csv) and whiffletree data file (*.wtr)

CG data (csv) file can only contain data for CG points while whiffletree data (wtr) file can contain both CG
points and whiffletree models. (This is of course because CG point is a part of whiffletree model.)

55 View and Edit Whiffletree Data

All whiffletree data can be viewed and managed in a separate window called Whiffletree Edit Window. The
window can be launched from the following icon or File Menu. The detail to manage whiffletree data is
explained in Section 6.0.

‘”":5] or File  View | Whiffletree | Help

— Open File

Save File

Build Whiffletree
Delete All Whiffletree

View or Edit Point

Change Point Size b

Figure 5-8
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5.6 View and Edit Whiffletree Material Data

Whiffletree material data can be opened, viewed, edited, and saved in a separate window called Material
Edit Window. The window can be launched from the following icon or File Menu. The detail to manage
whiffletree material data is explained in Section 7.0.

or File  View | Whiffletree | Help

Open File

Save File

Change Bearn Size k

View or Edit Matenal

Whiffletree Diagram

Export to Catia
\—/_\

Figure 5-9

5.7 View Whiffletree Diagram

Whiffletree diagram can be reviewed in a separate window. The window can be launched from the following
icon or File Menu. The detail about whiffletree diagram is explained in Section 8.0.

“.N or File View | Whiffletree | Help

Open File

Save File

Change Bearn Size k

View or Edit Matenal

Whiffletree Diagram

Export to Catia
\—/_\

Figure 5-10

5.8 Export to CATIA

Exporting whiffletree model into CATIA can be done in a separate window. The window can be launched
from the following icon or File Menu. The detail about exporting model in to CATIA is explained in Section

9.0.
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or File View | Whiffletree | Help
CATLA

Open File

Save File

Whiffletree Diagram

Export to Catia

Mo Bearn Length Warning

Figure 5-11

5.9 Build Whiffletree

Building whiffletree can be done by the following icon or File Menu. Take the following procedures described
in the following subsections.

or File  VWiew | Whiffletree | Help

Open File

Save File

Split Point (CG)

Build Whiffletree
Delete All Whiffletree

Wiew or Edit Point

Figure 5-12

5.9.1 Procedures

1. Click icon or start from File Menu. You will see a message “Select the first point” in Status Bar.

2. Pick the first point by clicking a point in Model Window by mouse. Zoom in/out or rotate the model as

necessary. Once you click a point, the point turns to yellow and the message in Status Bar changes to
“Select the second point.”

3. Pick the second point by clicking a point in Model Window by mouse. As soon as you select the second
point, a message will appear to confirm the connection between the points you selected.
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1) Message in Status Bar for the first point. _

Select the first point.

=]

\ m ‘!%-

Q\% \Q Q !ll "'
\ Bes

2) Point 1 is selected (color turns to yellow).

3) Message in Status Bar for the second point.

Select the second point.

4) Point 13 is selected as the second point.

5) Message will appear to confirm the connection.

3DWhiffletree ==

-

Connect Point1 and Point 137

QK l | Cancel

Figure 5-13
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4. Whiffletree is built with rods and beam (new point 18, 19, and 20 are created in this example).

A _\

New Whiffletree

Selected Points

Figure 5-14

Non-selectable points for whieeltree construction

You can select points for whiffletree only if they are CG points that are not connected with rods or the point
at the top of the tree. In summary belows are points that cannot be selected for whiffletree construction.

1. CG points that are alrady connected with a rod
2. Points that are already part of whiffletree (i.e., Beam)
3. Point for 2™ point that is already selected as the 1% point.

When selecting any of these points, you will see an error message shown in the figure below.
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Examples of Non-Selectable Points

3DWhiffletree ==

The peint is already a part of whiffletree.

3DWhiffletree ==

You have already selected this point as the first point.

3DWhiffletree

The point is already a part of Beam and cannot be selected.

Figure 5-15

5.9.2 Technical Background

Calculation method for whiffletree construction is shown below. In the below example the pulling direction is
assumed to be Z direction. Method is similar for the case of pulling direction in X or Y. 3DWhiffletree
program only can take the pulling direction parallel to major global axes (X, Y, or Z).
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Loading Direction; Z 4

/
Ly

/

>

P3 (X3i Y3i Z3i W3)

P2 (X21 Y21 221 WZ)

X
Pl (le Ylv Zlv Wl)

Figure 5-16

In the figure above, we want to find P; based on P; and P, properties. Therefore,
Find: P coordinate (X3, Y3, Z3) and Load (Ws)
Known: P, coordinate (X1, Y1, Z;) and Load (W;)
P, coordinate (X,, Y,, Z,) and Load (W,)
Direction to pull (+Z in this example)
By taking a moment about P3,
L,-W, =L, W,
IfL= Ll + L2, then

I-1 _ Wz
L W, +W,

Therefore,

W,

X =X =Xy T
1 2

+ X,

W,

——+Y,
W, +W,

Y, = (Yz - Yl)

W, =W, +W,

Note that default Z; value is automatically calculated by program based on the distance between P; and P3.
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5.10 Delete All Whiffletree

This command will delete ALL whiffletrees. To delete a part of whiffletree, use Delete a Point (See Section
5.12).

Delete All Whiffletree function is available through the following icon or File Menu.

or File  View | Whiffletree | Help

Open File

Save File

Split Point (CG)

Build Whiffletree
Delete All Whiffletree

View or Edit Point

Figure 5-17

Delete All Whiffletree will delete all rods, beams, and points except for CG points. You will see a
confirmation message. Click Yes will delete all rods and beams.

ADWhiffletree 3

Delete all whiffletrees (except for CG points)?

e ][

Figure 5-18
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Figure 5-19

5.11 Add a Point

The Add a Point function is available through the following icon or File Menu.

Help

Whiffletree

Open File

Save File

Open CG Data

Add Point

Delete Point

View

File

or

Figure 5-20

Procedures:

1. A separate window will open.

2. Fillout X, Y, and Z coordinate, Description, and Weight.

5-16
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Add Point ==
X &07
Y. -8355
£ 24183
Description: | Structure (Optional)
Weight: (Required to finalize)
Preview | [ QK ] | Cancel |

Figure 5-21

3. Click Preview to check the point. The new point will show in yellow.

Y i e AV iy
Wi
vi’l«'

2
a8 | ? ﬂ”’g')

LI 17 ) New Point (Preview
o i ( )

Figure 5-22

4. Click OK to finalize the point. The yellow point will turn to red. Weight must be greater than 0.
Description is optional.
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o i

New Point (Finalized)

Figure 5-23

5. You can check the new point from Whiffletree Edit Window. See 6.0 for detail about Whiffletree Edit
Window.
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Edit Whiffletree - [*wtr] (=230
ID Case Description L W M
Pull Direction |-X hd G-Factor 10 Other Factors 10 Wirers in b inb
. Decimals 0.00 HAHE HAERH
Warning Length 20
Ho Description Weight X ¥ Z Load Length
1 Cart (Fwd-Inkd) 150 &e00_80 =-71.00 221.35z a.00 -
2 Cart (Fwd-0Otkd) 150 &00.80 -87.45 ZZ1.32 0.00
3 Cart (Aft-Inkd) 150 &8l3_20 =-71.00 221.35z a.00
4 Cart (Aft-Otbd) 150 6813.20 —-87.45 2Z1.35Z .00
5 Refrigerstor 110 alg.47 -78.%0 Z58.20 0.00
& Glazss Rack Lower (Content) 15 &00_28 -T4_ 88 Zgl_88 a.00
7 zlzss Rack Upper (Content) 15 a00.28 -T4.88 Zg5.87 0.0a
a8 Attendant Module 3e &8Z9_&8 -&8_&80 2e7.87 a.0a
|El Structure 350 e07.00 -83.55 241.33 .00 |
~——— New Point Entry
No Description Weight H ¥ z Load Length
This poirt is a split with:
Update H Delete ] Close

Figure 5-24

5.12 Delete a Point (Delete Whiffletree)

The Delete a Point function is available through the following icon or File Menu.

‘ or File  View | Whiffletree | Help

Open File

Save File
Open CG Data

Add Point

| Delete F'n:nintl

Figure 5-25

There are two functions for this command: to delete a point, and to delete a whiffletree.

5.12.1 Delete a Point

Only CG points that are not connected can be deleted.
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1. Click icon or use File Menu to activate Delete a Point function. You'll see a message in Status Bar.

Select a point to delete.

Figure 5-26

2. Select a CG point that you want to delete. Below figure shows an example of deleteable CG points.

nlh

A " “ .
s ee il
il Sk S

A

' i

[
/ﬂ\ll\\\k\k\k\\\\"

Figure 5-27

3. A confirmation dialog will pop up. Click OK to confirm the point deletion.

3DWhiffletree

Are you sure to delete this point?

Point 3
Description: Cart (Fwd-Otbd)
Location: ¥ = 60080, ¥ = -B7.45, £ = 22192

[

QK | | Cancel

n

Figure 5-28

Deletable Points

Whiffletree Construction
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4. Point has been deleted. Note that point numbers have been updated automatically.

Point has been deleted.

VAT
A\II\\\\\\\R\R\\"

[ VL)

)r\\\\nn‘\\u—

Figure 5-29

Notes:
If you select any non-deletable points, you'll see the following warning message.

3DWhiffletree ==

-

Mon-deletable point!
You only can delete a point that is the end of the whiffletree or a CG that is not

yet connected,

Figure 5-30

5.12.2 Delete Whiffletree

Points and whiffletree (Beam and Rod) can be deleted if they are located at the top of whiffletrees. You
need to select the point located top of the whiffletree. Then, rod and beams only one level below of the

points will be deleted together.
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Deleting this point will delete this whiffletree.

A

L
Pl E “
[
A\II‘\\\]‘\“\]‘\R\\"

[ Y
ANV VVVVV T2

Deleting this point will delete this whiffletree.
Figure 5-31
Procedures are essentially the same as deleting CG points.

1. Click icon or use File Menu to activate Delete a Point function.

2. Select a point at top of whiffletrees.
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R EEEEERRRE

[ Y

Figure 5-32

3. Confirm in a pop up dialog message.

3DWhiffletree ==

Are you sure to delete this point?

Point 18
Description: Red: from 17
Location: X = 65247, ¥ = -79.53, £ = 23341

Ok l | Cancel

Figure 5-33

4. Point along with rods and beam are deleted. Note that point numbers will be automatically updated as
necessary.
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A

Points, beam, and rods are deleted.

[N
A\II\\\R\R\R\R\\"

Figure 5-34

5.13 Show Point Info

The Show Point Info function is available through the following icon or File Menu.

or File  View | Whiffletree | Help

Open File

=)

Save File
Open CG Data

Add Point
Delete Point
Show Paint Info

Figure 5-35

1. Activate Show Point function by clicking icon or from File Menu. You'll see a message in Status Bar.

Select a peint that you want get info.

Figure 5-36
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2. Click a point that you are interested. You can click any point including points that are part of rods or
beams. A message window will pop up.

IDWhiffletree ==

-

Point&

Description: Refrigerator

Weight: 110 [b

Load: 1,139 1b

Location: X = 61847 in, ¥ = -78.20 in, £ = 256.20 in

Figure 5-37

Remarks:

1. Weightis given only for CG points.

2. Load will be shown with units and decimal places set by users (See Section 6.8.)

3. X, Y, and Z values will be shown with units and decimal places set by users (See Section 6.8.)

5.14 Move and Edit Points

There are four types of moving or editing points in addition to directly editing point in Whiffletree Edit
Window. (See Section 6.0 for editing whiffletrees in Whiffletree Edit Window.) They are:

Move a Point (Along Loading Direction)
Split a Point

Move Two Points Together

Move a Point (In Plane)

2|$‘<|

\ e 55
w e b|e €

= Move a Point (In Plane)

= Move Two Point Together

= Split a Point

= Move a Point (Along Loading Direction)

Figure 5-38

5.14.1 Summary of Moving Points
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Table 5-3 summarizes different function of moving points.
Table 5-3

Final Loading
Points

Function Direction

Move a Point

(Along Loading Direction) Along loading direction Any No Change
Split a Point In plane perpendicular to loading direction CG Only No Change
Move Two Point Together In plane perpendicular to loading direction CG Only No Change
Move a Point (In Plane) In plane perpendicular to loading direction CG Only  Will Change (*1)

Notes:

(*1) If the point you are moving is a split point (and have not been forgotten), then, the point will only move
with other split point. This behavior is exactly same as Move Two Point Together, unless you forget the split
between two points. See Section 6.11 for how to forget split.

5.14.2 Move a Point (Along Loading Direction)

This command will move any points along loading direction. Any points (CG, rod, or beam) can be moved.
The final loading point will not change. This command is useful when you want to:

e move a CG Point to accurate location where actually loaded in the static test,
e clean overlapped beams and rods, or
e adjust rod lengths to be more accurately represent actual static test.

The Move a Point is available through the following icon or File Menu.

or File  View | Whiffletree | Help

Open File

7

Save File

MMowve Point (In Pull Direction) I

Mowe Two Points
Mowve Point (In-Planeg)

Split Point (CG)
\—/_\

Figure 5-39

1. Activate Move a Point function by clicking icon or from File Menu. You'll see a message in Status Bar.
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Drag a point that you want to move.

Figure 5-40

Since this function is frequently used, a shortcut key is also available.

Shortcut Key: Hold SHIFT Key and drag a point by mouse left button

2. Click and drag the point you want to move by mouse left button.

Moving Point

- ’

Figure 5-41

3. While dragging a point, the point turns to yellow.

Moving Point

Figure 5-42

4. If you pick a point that is part of beam, three points consist of the beam will move together.
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Figure 5-43

5.14.3 Split a Point

This command can split a CG Point into 2 new points. Final load point and overall CG will not change. This
command is useful when you want to:

e Distribute a loading points, or
e Split a loading point to avoid interferences with test fixture.

The Split a Point is available through the following icon or File Menu.

|¢"'1.- or File  View | Whiffletree | Help
&

Open File

Save File

MMowve Point (In Pull Direction)
Mowe Two Points

Move Point (In-Planeg)

Split Point (CG)

-

Figure 5-44
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1. Activate Split a Point function by clicking icon or from File Menu. You'll see a message in Status Bar.

Select and drag a peint that you want to split.

Figure 5-45

2. Select a point by mouse left button and drag it. While dragging, two new yellow points will dynamically

X

appear showing new split points.

ALY
L)/\HKHAYL

Click and drag a point

While dragging, two new points
will dynamically appear.

Whiffletree
ID | TESTIF Pull Direction +X,
G-Factor 9.0 Split Wt Ratio  1.00 \
Other Factor | 1.15.1.15 Split will occur based on the Split
Weight Ratio (default = 1.0)
- :'||: - ",| I 7 j?)"
WTR || WTR (] ra B, || Sarea
4= ? [ h
2o L R N P B e
%’ ‘ 5 /— Location of one of new split point
¥ 61320 ||y | 8305 || 7z | 21837 (base point) will be shown.
Figure 5-46
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3. Once you drag the point at approximate desired locations, release the mouse left button. Then, below
window will pop up. In the window you can fine-tune the location or split ratio.

3DWhiffletree =

Accept or Edit the split as follaws: Ratio can only be edit at main

‘ ’ window (Whiffletree Panel)
Weight Ratio P1:P2 = | 1.00

Cart {Aft-Othd) Wi 1500
Criginal Point - -
S 613.20 Y 87 45 7 7137

-

Edit new point names

Edit weight. Coordinate of both points
(New Point 1 and New Point 2) will be
automatically updated. This will
overwrite weight ratio specified
above.

New Foirt 1 | Cart (Aft-Othd) - Spit 1/2 [

[Cart (A-Otbd) - Split 2/2 | we [ 750
[x [ 6320 [y w4 [z 21767

|
|4—/ Edit exact location. Loading
direction cannot be edited.

“four base point is Point 2 (Paint No. 21). Coordinate of other points (New
Point 1) will be automatically
| ok || cancsl | updated.

\

Temporary point IDs (not final ID)
Figure 5-47

Remarks:
a) Weight Ratio:
“P1:P2 = 1.00” means weight are distributed equally. For example, “P1:P2 = 2.0” means P1 weight
will be distributed twice of P2 weight.
b) Default Name

Following suffix will be added to the new points

New Point 1: “Original Name” — Split 1/2
New Point 2: “Original Name” — Split 2/2

c) Weight:
Weight distribution can be edited. The new weight distribution will overwrite the Weight Ratio. (i.e.,
no matter what the weight ratio is, the new weight can be distributed as entered in the weight box.)

4. Click OK to confirm. Then, whiffletrees will be updated with split points.

Remarks:

Once a point is split, the new split points cannot be recovered. There is no command to combine two points
into one.
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New split CG points

New rods and beam are

automatically created for split points

Figure 5-48

5. You can check split points in Whiffletree Edit Window.

Edit Whiffletree - [561WhiffleTree.wtr] (=]
ID TESTSF Case Description Bar 561 Fwd 3G L W M
Pull Direction |+ = G-Factor 50 |other Factors 1.15 1.15 iR in b indb
- Decimals 000 H#H HAHE
Warning Length 20
No Description HWeight X ¥ z Load Length
[ zlzss Rack Lower (Content) 5 ad0.28 74.8% Zgl.B8 175 0.00 |T
7 Elass Back Upper (Content) 15 e00_28 =74 _ 88 Z289._87 17 0.0a0
=] Attendant Module 3% eZ9.a8 —e8.&0 2e7.87 0.00
=] Rod: from 4 &8Z3._a8% —-71.00 221.5zZ 1,785 8.2ZZ
10 Rod: from 23 823 _&8% —-87._.45 221.582 1,785 8.23 —
11 Beam: between 3 & 10 823.8% -T73.23 Z21.32 3,571 0.00
1z RBod: from 11 &4l 53 -75_23 221.582 3,571 4_0Z
13 Rod: from & eZ3.30 —-74.88 Zgl.BB 173 3.9%5
14 Rod: from 7 &8z5_30 —-74_88 283.87 175 3.9%
15 Beam: between 13 & 14 8259 _30 —-74_ g8 2e5_88 357 [ L]
la Rod: from 15 a4l.53 -74.88 Zg5.88 357 40.18 =
17 Beam: between 12 & l& &4l 53 -78.81 225.82Z 3,528 [ L]
1 Rod: from 17 &e58.35 —-78.81 225.52Z 3,928 0.00
19 Cart (Aft—Otbd) - Split 1/2 75 8l3_20 —81_50 226_17 893 7.31
20 Cart (Aft-0Otkd) - Split Z/2 75 &8l3_Z0 —-53._40 217 .87 833 7.81
z1 Rod: from 13 2lB.44 -81.50 228.17 893 7.31
ZZ Rod: from 20 els_ 44 —-53._40 217 .87 833 T.31 Ll
Z3 Bezam: between 2ZZ & Z1 elo.44 —-87.45 Z221.52Z 1,785 0.00 |'
No Description HWeight X ¥ & Load Length
19 | Cart (AMft-Otbd) - Spit 1/2 7 613.2 -21.5 22617 892 6875 7.311976476
This poirt is a splt with: | 20 Forget Split
\

\— This will remove a link between two split points.

If the point is a split, other point ID is shown here.

Figure 5-49
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Remarks:

What is for?

When a CG Point is split, the new points will be linked as split points. This is to ensure that the overall CG
will not change when moving a point in plane (see Sec 5.14.5). Forget Split will delete this link and make
these split points to an individual CG Point.
By clicking Forget Split button,

e Split information is permanently removed.

e Other split point will be automatically updated.

¢ Point name will not be changed automatically. (i.e., if the name contains “- Split 1/2", then it remains
unchanged.)

5.14.4 Move Two Points Together

This command can move two CG Points together in a plane perpendicular to the loading direction while
keeping overall CG being unchanged. This command is useful when you want to:

e Adjust whiffletree loading points but keep the same overall CG

The Move Two Points is available through the following icon or File Menu.

“% or File  View | Whiffletree | Help

Open File

e o

Save File

Maowe Point (In Pull Direction)

Move Two Points I

Move Point (In-Planeg)
Split Point (CG)
\—/_\

Figure 5-50

1. Activate Move Two Points function by clicking icon or from File Menu. You'll see a message in Status
Bar.

Select the first point.

Figure 5-51

2. Once selecting the first point, the selected point turns to yellow. Then, you’'ll see the next message in
Status Bar.
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Select the second point.

Figure 5-52

3. Once selecting the second point, both selected points now turn to yellow. Then, you'll see the next
message in Status Bar.

Drag either point you have selected.

Figure 5-53

4. Dragging either point in yellow will dynamically update the whiffletrees. Overall CG will not change. The
distance that the other point moves depends on the weight ratio of the two selected points.

e
#55
fﬁ_ ,ﬂfﬁ_i
ﬁf ff'”
e N Py

ﬂ"#-_;ﬁ“::
oy | LT
o [
f-"*’_ﬁ,f-‘“ﬁ
1 #,f’*ﬁ

:fﬁ,ff”/— This point remains
. 7ﬁ the same.
/ﬁr”ﬂ
-l"-'-'-'-'-'-l
| — |
_F"'FFFH-'
|~ -1
.,-r"""f
L~ .-'-'""-F'
f”’ﬂjﬁ-f
x‘f,ﬂ“
.-"'F-'H_‘__'_,.-
.___,.,-"

<

Figure 5-54

5.14.5 Move a Point (In Plane)
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This command will move a CG Point in a plane perpendicular to loading direction. Depending on the moving
point, there are two different results.

e Moving a Split Point will result in the same move as Move Two Points Together previously
described in Section 5.14.
e Moving all other points will result in change in overall CG.
The Move a Point (In Plane) is available through the following icon or File Menu.

‘ or File  View | Whiffletree | Help

Open File

Save File

Move Point (In Pull Direction)
Move Two Points
Mowe Point (In-Plane) I

Split Point (CG)
e ——— L

Figure 5-55

1. Activate Move a Point (In Plane) function by clicking icon or from File Menu. Because this function will
change the original overall CG, the following message will appear to ensure that the use is aware of this
function.

3DWhiffletree ==

-

Warning - Understand how this function works,
This function moves the selected point independently. Unlike the other functions

that mowve the points, UMLESS THE POIMT IS SPLIT POIMT, this function will
change the overall CG, which may cause mismatching with the criginal CG data.

Figure 5-56

2. Then, you'll see a message in Status Bar.

Select and drag a point that you want to move.

Figure 5-57

3. Select a point and drag it to the desired location. There are two different results depending on the type
of point you choose.
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1)

2)

Split Points

If the selected point is a Split Point, the selected point will move together with the other linked split
point. The behavior is exactly same as Move Two Point Together as described in Section 5.14,
except you select one point instead two points. Therefore, the overall CG will not change.

Other CG points
The point will freely move independently on the other points. Therefore, overall CG will change.

Move this point (not split point)
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Total CG will change.
(Whiffletrees will be updated accordingly.)

Figure 5-58

5.15 Change Point/Rod/Beam Sizes

Point, Rod, and Beam size can be changed from the following menus. (There is no icon for these
commands.) Note that the change of size is temporary and will not be saved.
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File

File

View

View

Whiffletree | Help

Open File

Save File

Build Whiffletree
Delete All Whiffletree

Wiew or Edit Point

Change Point Size

Change Rod Size

Change Bearn Size
View or Edit Material

Whiffletree Diagram
Export to Catia
Mo Bearn Length Warning

8 (Default)

4
]

10
12
14

Figure 5-59

Whiffletree | Help

Open File

Save File

Build Whiffletree
Delete All Whiffletree

Wiew or Edit Point

Change Point Size

Change Rod Size

Change Bearn Size
View or Edit Material

Whiffletree Diagram
Export to Catia
Mo Bearn Length Warning

1

2 (Default)

3

4
5
6

Figure 5-60
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1
2

3 (Default)
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5.16 No Beam Length Warning

By default, 3DWhiffletree provides warning message when beam length (one of the moment arms) become
less than specified length (default is 2 inches).

3DWhiffletree £

Warning!
One of the beam length is less than 2in.

Point 10: 1.73in
Point11: 17.34in

Do you want to turn off this warning message?
(You can turn it back from "Whiffletree" > = "No Beam Length Warning”.)

ves || No

Figure 5-63

You can change the setting so that such warning message will not appear by checking “No Beam Length
Warning” in the File Menu.

File  Wiew | Whiffletree | Help

Open File

Save File

View ar Edit Material

Whiffletree Diagram
Export to Catia

Mo Beam Length Warning

Figure 5-64

This function is useful when you are moving the CG point and get this message. In such a case, unless you
turn on this function, you will be stack and cannot move or change the whiffletree anymore as the warning
message keep showing if you try to move the point.
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6.0 VIEW AND EDIT WHIFFLETREE DATA

This section explains how to view and edit whiffletree data through Whiffletree Edit Window.

Whiffletree Edit Window can be accessed by the following icon or File Menu. (The name “View or Edit Point”
in File Menu is not intuitive for this command. In fact, it can do more than just view or edit points.)

=2 T &
?ﬂ.-r “\q:‘t

= or File View | Whiffletree | Help
= Open File
&‘ Save File

Delete All Whiffletree

WTR
+

L
Ir:‘
b

%87

bat

Yiew or Edit Point

Change Point Size 3
Change Rod Size 3

-

Figure 6-1

6.1 Display General

Figure 6-3 on the next page shows a typical view of Whiffletree Edit Window.

All data and information in the window will be saved in *.wtr file when saved. The *.wtr file name will appear
on the top of window.

* wtr file name

A
( A

Edit Whiffletree - [361WhiffleTreed witr]

Figure 6-2
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ID (Section 6.2) Units & Decimals (Section 6.8)
Pull Direction (Section 6.4)
Warning Length (Section 6.7)
G Factor (Section 6.5)
f /— Description (Section 6.3)
/

Edit Whifletree - DilwhifﬂeT,éa.m;y ’/ /
I ID TESTSF f Case Descrjption Bar 561 Fwd 3G I | L | W | M
| Pull Direction [+X = / G-Factor 5.0 IOther Factors 115 1.15 I iR in b indb
N Decimals 000 HiH Hi
Warning Length 20
No | Description | HWeight | X |\ ¥ | z | Load Length
1 Structure 358 al0e_ 31 -75_.7% 243 42 4, 713 a.00 -
2 Cart (Fwd-Inbd) 150 &e00_80 =-71.00 221.582 1,785 [ L] il
3 Cart (Fwd-Otbd) 150 a00.80 -87.45 Z21.32 1,785 0.00
4 Cart (Aft-TInkd) 150 &8l3_Z0 =-71.00 221.582 1,785 [ L]
5 Cart (Aft-Otbd) 150 8l3.20 -87.45 Z21.32 1,785 0.00
= Refrigerator 110 ela_ 47 —-78.50 258_Z20 1,305 a.00 =
7 Glass Rack Lower (Content) 15 &00_28 -74_&66 261 _B8 179 0._00
2] Glass Rack Upper (Content) 26
5 Attendant Module 38 8259 &8 —-88_&0 287.87 428 [ L]
10 Rod: from 4 8lB.9¢ T1.00 Z21.32 1,785 B.ZZ |
11 RBod: from 5 &la_3¢& 87.45 Z221.582Z 1,785 8.23
1z Beam: between 10 & 11 &8l8_35& T5_Z23 221.582 3,571 [ L]
13 Rod: from 12 830.27 TS_Z3 Z21.32 3,571 10.21
14 Bod: from Z 48 _ &% —{71.00 221.582 1,785 8.31
15 Rod: from 3 a4B8.83 -E8.e0 Z287.87 4z8 37.11
1&g Beam: between 14 & 15 48 _ &89 -10.54 230.81 Z,214 a.00
17 Bod: from 1@ e78._43 —A0_54 230.81 Z,214 12 22
18 Rod: from 1 8l5.18 -TE.73 £43.42 4,713 a.27 &
| No | Description Weight X ¥ | z | Load | Length
a8 Glass Rack Upper (Content) 15 600.277 -74. 269.87 178.5375
|Thi5 point is a split with: Farget Spiit
Update Delete Close
T s 1

/ \\ Other Factors (Section 6.6)

Edit Area (Section 6.10)

Data Screen (Section 6.9)

Figure 6-3

6.2 ID

ID TESTSF

ID can be any strings in any length, and it's optional (can be left blank). ID can be used as a root number of

whiffletree beam IDs when showing ID on whiffletree diagram (Section 8.4.2). You need to click to
confirm the change.
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1,785 Ib _
16.56 in Cart (Fwd-Otbd)

6499 Ib TESTSF-20

8.81in

G.27 in

Structure

TESTSF-31

8.23in
10.21in| 3571 1b

ID is used as root number of beam ID

8.22in| 1,785 b

Cart (Aft-Inbd)

Figure 6-4

6.3 Case Description
Case Description Bar 561 Fwd 9G

Case Description can be any strings in any length, and it's optional (can be left blank). It is only for your
purpose to identify your whiffletree. You need to click to confirm the change.

6.4 Pull Direction

Pull Direction |&& -
+,
+1
+
-,

Y
-

Pull Direction determines the loading direction of the whiffletree. It's a dropdown menu and the default value
is “-X". It can be changed only if there is no whiffletree constructed. In other words, if there are any
whiffletrees (beam and rods) created in the whiffletree model, you cannot change the Pull Direction value.
Therefore, always make sure to set the correct Pull Direction value before you create any new whiffletree
connections. If you try to change Pull Direction value after creating any whiffletrees, you will see the

following message. You need to click to confirm the change if you edit the value.
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-

3DWhiffletree ==

You cannot change Pull Direction once you started creating whiffletree,

Figure 6-5

Remarks:

The Pull Direction value can be chosen only in parallel to global axis (X, Y, Z). If you need to load in
arbitrary direction, adjust FEM model so that the desired loading direction can be in line with one of global
axis.

6.5 G-Factor

E-Factor 50

G-Factor is a multiplication factor applied to the weight to get a load. Together with Other Factors (Section

6.6), the final loading values are determined. You need to click | Updete | to confirm the change if you edit
the value.

6.6 Other Factor

Other Factors 1.15 1.15

Other Factors are additional factors applied to the weight. You can enter as many factors as you want by
separating each factor by comma. (Spaces after comma is optional and not required). You need to click

[ Updete | to confirm the change if you edit the value.
For example, by entering
1.15, 1.15
will result in the factor
1.15x 1.15 (=1.3225)
and will be multiplied to the weight together with G Factor.

Below figure shows an example of how the load is calculated from Weight, G Factor, and Other Factors.
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No Description Weight H ¥ F Load Length
1 Structure 338 &0&.31 -73.73 243 .42 4,713 0.00
396]x 9.0 x 1.15 x 1.15 =[4713] Example:
/l \\ How the load is computed

E-Factor 9.0 Other Factors 1.15 1.15

Figure 6-6

6.7 Warning Length
Warning Length 20

Warning Length will set the value and provide warning message when moment arm of any whiffletree
beams become less than the value (an example figure below). Default value is 2.0. You need to click

to confirm the change if you edit the value.

3DWhiffletree 3

Warning!
One of the beam length is less than 2in.

Point 10: 1.73in
Point11: 17.34in

Do you want te turn off this warning message?
(You can turn it back from "Whiffletree” » = "Mo Beamn Length Warning".)

ves || No

Figure 6-7

As explained in Section 5.16, there won't be any warning message when “No Beam Length Warning” is
turned on.

6.8 Units and Decimals
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L W M
Units in Ib indb
Decimals 0.00 HHEH HHE

Units and Decimals controls displaying units and decimals. The default values are as shown above. The
units are mainly for the use in Whiffletree Diagram. The below figure shows an example of whiffletree
diagram with default units and decimals. (Moment in beam is also set to shown in this example.) You need

to click to confirm the change if you edit the value.

1,785 Ib _
18.568in Cart (Fwd-Otbd)
5,450 |b )
5&1in 29,558 in-lb
8.27in| 47131b
————————— Structure
36,460 in-lb
1,785 Ib _
27%in Cart (Af-Otbd)
1021 357116 14,685 in-Ib
322in| 178510
—————— Cart{Afi-Inbd)
Figure 6-8
Rules Decimal Format
L: Length
h W: Weight (Load)
+— M: Moment
L W M
Units in b indb

Decimals 0.00 #,### #,###

Figure 6-9

Decimal format is per visual basic format. For examples, this can be used to limit number of decimal places
or add a thousand-separator in the figure. The default value will work for the most common cases when
using US units (inches and pounds). This function is useful when using Metric units and need to control
decimal places.

Refer to the following table for the rules of formatting.
Remarks:

Changing decimal places only affects the format of displaying values, not actual values stored in database.
No figures in decimal places will be lost by changing the format.
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Table 6-1

Character Description

None

()

#)

)

()

Displays the number with no formatting.

Digit placeholder. Displays a digit or a zero. If the expression has a digit in the position where
the zero appears in the format string, display it; otherwise, displays a zero in that position. If the
number has fewer digits than there are zeros (on either side of the decimal) in the format
expression, displays leading or trailing zeros. If the number has more digits to the right of the
decimal separator than there are zeros to the right of the decimal separator in the format
expression, rounds the number to as many decimal places as there are zeros. If the number
has more digits to the left of the decimal separator than there are zeros to the left of the
decimal separator in the format expression, displays the extra digits without modification.

Digit placeholder. Displays a digit or nothing. If the expression has a digit in the position where
the # character appears in the format string, displays it; otherwise, displays nothing in that
position. This symbol works like the 0 digit placeholder, except that leading and trailing zeros
aren't displayed if the number has fewer digits than there are # characters on either side of the
decimal separator in the format expression.

Decimal placeholder. The decimal placeholder determines how many digits are displayed to the
left and right of the decimal separator. If the format expression contains only # characters to the
left of this symbol; numbers smaller than 1 begin with a decimal separator. To display a leading
zero displayed with fractional numbers, use zero as the first digit placeholder to the left of the
decimal separator. In some locales, a comma is used as the decimal separator. The actual
character used as a decimal placeholder in the formatted output depends on the number format
recognized by your system. Thus, you should use the period as the decimal placeholder in your
formats even if you are in a locale that uses a comma as a decimal placeholder. The formatted
string will appear in the format correct for the locale.

Thousand separator. The thousand separator separates thousands from hundreds within a
number that has four or more places to the left of the decimal separator. Standard use of the
thousand separator is specified if the format contains a thousand separator surrounded by digit
placeholders (0 or #). A thousand separator immediately to the left of the decimal separator
(whether or not a decimal is specified) or as the rightmost character in the string means "scale
the number by dividing it by 1,000, rounding as needed." Numbers smaller than 1,000 but
greater or equal to 500 are displayed as 1, and numbers smaller than 500 are displayed as 0.
Two adjacent thousand separators in this position scale by a factor of 1 million, and an
additional factor of 1,000 for each additional separator. Multiple separators in any position other
than immediately to the left of the decimal separator or the rightmost position in the string are
treated simply as specifying the use of a thousand separator. In some locales, a period is used
as a thousand separator. The actual character used as the thousand separator in the formatted
output depends on the Number Format recognized by your system. Thus, you should use the
comma as the thousand separator in your formats even if you are in a locale that uses a period
as a thousand separator. The formatted string will appear in the format correct for the locale.

Reference:http://msdn.microsoft.com/en-us/library/microsoft.visualbasic.strings.format.aspx

The decimal formatting will also affect the displaying values in Data Screen. See the following figure as an

example.
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| 'z [ w [ u Format: #,### Format: #,###

Units in b indb Format: 0.00 Format: 0.00
Decimals 000 HuEEH HiHE

| No | Description | Height | H \ | ¥ | Zz | *Dad | angth
1 Structure 35e e0g.591 -75.7% 243 .43 4, 713 0.00 -
Z Cart (Fwd-Inkd) 150 &00.80 -71.00 221.92 1,785 0.00 b
3 Cart (Fwd—Otkd) 150 e00.80 -B87.45 221.53 1,785 0.00
4 Cart (Aft—Inbkd) 150 g8l3.20 -71.00 221.52 1,785 0.00
5 Cart (RAft—0Otkd) 150 el3.Z0 -B87.45 221.53 1,785 0.00
= Refrigerator 110 el8.47 -78.50 256,20 1,308 0.00 E
7 Elass Rack Lower (Content) 15 a@00_28 -T74 88 Z81 .88 175 a.aa0
=] Glass Rack Upper (Content) 15 e00.28 -74.6%6 285 .87 175 0.aa
9 2ttendant Module 36 BZ9_6B —gB._.&e0 Ze7.87 4z 0.aa0
10 Rod: from 4 el8.59¢ -71.00 221.52 1,785 8.22 i
11 Rod: from 5 el8_9¢ —87 .45 ZZ1_39Z| 1,785 B.23
1z Beam: between 10 & 11 gl8.59¢ -75.23 221.53 3,871 0.00
13 Bod: from 12 830_27 -79_23 ZZ1_39Z| 3,571 10.21
14 Rod: from 2 48 .83 -71.00 221.53 1,785 8.91
15 Rod: from 5 8438 .83 —gB._.&e0 Ze7.87 4z 37.11
1a Beam: between 14 & 15 48 .83 -70.54 230.81 Z,214 0.00
17 Rod: from lé aeT8.43 -70.54 Z230.81 2,214 12.22
1s Rod: from 1 gl15.18 -75_75 243_43| 4 713 .27 S
Changing Decimal Formatting (Click ‘)
| ENERE Format: 0.0 Format: 0.0

Units L Format: 0.000 Format: 0.000

| Decimals [0.000][ 00| #am

| No | Description | We*ﬂu: | x \ | i | Z | Fuad | ﬁanth
1 Structure 2.0 0&.303 -72.787 243.423 47134 a.aa0 -
z Cart (Fwd-Inbd) 150.0 00.800 -71.000 221.58z20 1785._4 a.000 N
3 Cart (Fwd-Othkd) 150.0 00.800 -87.450 221.820 1785.4 0.000
4 Cart (Aft-Inbd) 150.0 13.200 —=71.000 221 .520 1785.4 a.00a
] Cart (Aft-Othkd) 150.0 13.200 -87.450 221.820 1785.4 0.000
@ Refrigerator 110.0 18.470 —78.500 258204 1305.3 a.00a =
7 Flass Rack Lower (Content) 15.0 a0.277 -T4. 858 281.884 17&8.5 a.000
=} =lass Rack Upper (Content) 15.0 ao.277 —T74_g56 2859874 178.5 a.00a
g Attendant Module 3€.0 29_.€80 —-&8.&00 287.870 428.5 a.000
10 Bod: from 4 0.0 18.358 —-T71.000 221.320 1785.4 8.225 b
11 Bod: from 5 0.0 18.358 -87.450 221.8z20 1785.4 8.225
12 Beam: between 10 & 11 0.0 18.358 -T8.Z25 221.820 3570.8 0.000
13 Bod: from 12 0.0 30.270 -T8.Z25 221.8z20 3570.8 10.211
14 Bod: from 2 0.0 48 . 894 -71.000 221.820 1785.4 8.30&
15 RBod: from 3 0.0 48694 —-&8. €00 287.870 428.5 37.107
1& Beam: between 14 & 15 0.0 48 . 894 -T70.535 230.814 2213.8 0.000
17 RBod: from 16 0.0 TE.428 -T70.535 230.814 2213.5 12.2z0
18 Bod: from 1 0.0 15.180 -79.787 243.423 4713 .4 &.271 e
Figure 6-10

6.9 Data Screen

Data Screen shows detail information of each point that constructs full whiffletree. Table 6-2 explains some
important facts in Data Screen.
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No Description Weight X ¥ Z Load Length
1 Structure 338 &le.391 -789.7%9 243 .42 4, 713 a.a0 -
2 Cart (Fwd-Inkd) 150 &00.80 -71.00 221.38:2 1,785 0.a0
3 Cart (Fwd-Otkd) 150 &00.80 -87.45 2Z1.38z2 1,785 a.0a0
4 Cart (Aft-Imnkd) 150 &13 .20 -71.00 2z1.3z2 1,785 a.a0
5 Cart (Aft-Otkd) 150 813 .20 -87.45 221.3z2 1,785 a.aa
& Refrigerator 110 618 .47 -78.30 258.20 1,30%8 a.aa =
7 Elass Back Lower (Content) 15 a00. 28 -T74 .68 2gl.88 1759 a.aao
=} Glass Rack Upper (Content) 15 &00._28 —-74._66 Ze5.87 179 a.aa
g Attendant Module 38 G629 .88 -g8.80 287.87 428 a.a0
10 Bod: from 4 &l8.39& -71.00 221.38:2 1,785 g.22
11 Bod: from 5 &lE.96 -87.45 2Z1.38z2 1,785 8.23
1z Beam: between 10 & 11 &l8.9& -T8.23 2z1.3z2 3,571 a.a0
13 Bod: from 12 &830.27 -75_23 221.3z2 3,571 10.21
14 RBod: from 2 G438 .89 -71.00 2z1.5z2 1,785 8.91
15 Bod: from 9 G48. 69 -g8.80 287.87 428 37.11
1& Beam: between 14 & 15 &48 .89 -70.54 230.81 2,214 a.a0
17 Bod: from 16 &7T8.43 -70.54 230.81 2,214 12.22
18 Bod: from 1 &l5.18 -78.7%9 243 .42 4, 713 &8.27 e

Figure 6-11

Table 6-2

ltems Explanations

No

Description

Weight

The number corresponds to the point ID of the model in Model Window. The
number is not a fixed number and can be changed as you edit whiffletree, but
always shown in order of small to large number.

There is a limit in number of characters to be displayed in Data Screen. However,
any length can be stored in database.

Non-zero weight value is displayed for CG points. Other points that do not have
weight will be displayed either blank or zero depending on your decimal format
setting. By default setting, weight is only displayed for CG Points.

Values will be displayed for all points.

Values will be displayed for all points. This is the load acting on the point.

This is moment arm length in beam and only shown for Rod (each end of beam).
CG points and Beam (middle point of the beam) do not have length; therefore, it is
displayed as zero.

6.10 Edit and Update Data

Whiffletree data can be edited and updated through Data Screen.

1. Select time that you want to edit.

2. The selected item is displayed in the bottom pane.

3. Edit values. Note that only editable items can be accessed. Other items are locked (grayed out).

See table below for edit permit of each item.
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4. Once you have done editing, click to confirm change. Whiffletree models in Model Window
will be automatically updated too.

Click item that you want to edit.

No Description Weight H ¥ z Load Length
1 Structure 3%e e0a.51 -79.73 243.42 4,713 0.00 -
2 Cart (Fwd-Inkd) 150 &00.80 -71.00 2Z1.82 1,785 0.00
3 Cart (Fwd-Otb 150 &00.80 -B87.45 2Z1.82 1,785 0.00
4 Cart (Aft-Inkd) 150 gl3.20 -71.00 2Z1.52 1,785 0.00
5 Cart (Aft-Oybd) 150 €1l3.20 —-87.45 ZZ1.5z2 1,785 0.00
[ Befrigeratgr 110 £18.47 -78.580 258_20 1,30% 0.00 £
7 Glass Rac) Lower (Content) 15 &00.28 —-74.648 Zgl.88 175 0.00
g Glzss Rggk Upper (Content) 15 g00.28 -T4.88 Ze5.87 175 0.00
] Ettendant Module 38 823 _88 -&88.80 287.87 478 0.00
10 Bod: from 4 £18.96 =71.00 221._592 1,785 8.22
11 Bod: from 5 gla.%e -B87.45 2Z1.52 1,785 8.23
1z Besm: between 10 & 11 gla.%e -T3.23 2Z1.52 3,571 0.00
13 Bod: from 12 &30.27 -73.23 2Z1.82 3,571 10.21
14 Bod: from 2 g48.83 -71.00 2Z1.582 1,785 8.51
15 Rod: from 9 cdd. g -gg8.g0 2e7.87 4z 37.11
18 Beam: between 14 & 15 g48 .83 -70.54 230.81 Z,214 0.00
17 Bod: from 1€ £78.43 -70.54 230.81 Z,214 1z .22
13 Bod: from 1 gls.1l8 -79.73 243.42 4,713 g.27 S
No Description Weight H ¥ & Load Length
o1 10 | Rod:from 4 618.95 Al 221.92 1785.375 B8.224999939!

This point is a split with:

@Selected item will be displayed for edit.

Items

No
Description
Weight
X, Y, Z
Load
Length

Forget Split

Figure 6-12

Table 6-3
Edit Permit

None
CG Points only

CG Points only

CG Points: Fully editable
Other points: Only loading component

None

None

Yes

Only editable items can be unlocked.
Other items are grayed out.

Remarks

Automatically assigned by the program

Automatically computed by the program
Automatically computed by the program

For Split Points only
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6.11 Split and Forget Split

You can remove the link between two Split Points. Refer to Section 5.14.3 for details of this function.

6.12 Delete

As explained in Section 5.12.1, whiffletree data point can only be deletable if the point is located at the top
of the whiffletrees. Delete button is locked if you select items which is not deletable.

Click to delete the point. Rest of whiffletrees (including IDs) will be automatically updated.

| Ho | Description | Weight | 4 | if | Z | Load | Length
17 Bod: from 16 &78.43 -T0.54 230.81 2,214 12 22 -
18 Bod: from 1 gl5.18 -Ta.78 243.42 4,713 g.27
153 Bod: from 3 gl5.18 —-87.45 221.%82 1,785 16.5&
20 Beam: between 13 & 15 g15.18 -81.8% 237.51 &,4593 0.0a0
21 Bod: from 20 &30.27 -81.8% 237.51 &,4593 5.8l
22 Bod: from & &25.30 -78.30 258,20 1,308 0.85
23 Rod: from 7 €25.30 -T4.68 2€l1.88 175 g.24
24 Beam: between 22 & Z3 €25.30 -78.38 25¢6.88 1,488 0.00
25 Bod: from 24 &44 25 -T78.38 256.88 1,488 1.45 —
2E Bod: from 8 g44 Z5 -T4 .88 285.87 1745 1z2.07
27 Beam: between 2& & Z5 &44 25 -77.9%8 25827 1,&E6 0.00
28 Bod: from 27 &78.43 -77.3%8 258.27 1,&E€6 16.23
25 Beam: between 17 & Z8 &78.43 -T3.74 242 .81 3,880 0.00 =
30 Bod: from 29 708.35 -T3.74 242 .81 3,880 5.27
31 Beam: between 13 & Z1 €30.27 -80.35 231.58 10,070 0.00
32 Bod: from 31 708.35 -80.35 231.388 10,070 3.57
33 Beam: between 30 & 32 708.35 -78.34 234.54 13,350 0.00

| No | Description Weight H L | Z | Load | Length

34 | Rod: from 33 727 5428154! (-78.94115308!( | 23453512841 | 13545 72404!

|Thi5 point is a split with: Forget Split
[ |Update l [ Delete ] [ Close

Delete button becomes enabled when selected item is deletable. —/

Figure 6-13
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7.0 VIEW AND EDIT WHIFFLETREE MATERIAL

This section explains how to view and edit whiffletree material through Edit Material.

Window for Edit Material can be accessed by the following icon or File Menu.

= or . . -
—— == || = i X File  View | Whiffletree | Hel
wie) e | oo (A | L ) 25 —
+ - — T oe Open File
o 0] % | Ny iy &‘ Save File
%’ %’ Change Bearn Size 3

[ View or Edit Material |

Whiffletree Diagram

Export to Catia

—  —

Figure 7-1

7.1 What is Material for?

3DWhiffletree program can automatically select the best material for beam and rod and display them on
whiffletree diagrams. For the program to be able to select, users need to specify material of beam and rod. If

you create multiple materials in the list, the program will choose from the weakest material that meets the
strength requirement.

Hd-in Rod

Beam Material —————————— Glass Rack Lower (Content)
l;m" d_l2-in cH

e L Refrigerator
3g-inRod \. . N~——"
— N-inCH
38-in Rod
\mu/ =lass Rack Upper (Content)
Rod Material
Figure 7-2
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7.2

General View

There are two views: Rod and Beam. The view can be switched by selection Rod/Beam icons.

Rod View
Materials for Whiffletree Construction - [Material.mil]
— H / % | | Ivy | c, D | Ftu | Fa | Ma
MTL| MTL -
Decimals 00000 0000 #HAEH HHEEH HiE
| Bod
|ID | Description Dia | F tu | P allow |U5Ed
1 3/8-in Rod 0.375 45, 000 4,970 Yes -
Z2 1/Z-in Bod 0.500 45, 000 g8,83¢ Yes
|ID | Description Dia F tu | P allow |U5Ed
-
[ Add Mew ][ Delete ] [ Update ] [ Close ]
Beam View
Materials for Whiffletree Construction - [Material.mtl]
;:_-L l;?"-‘/‘&/ | | Iyy | =, D | Ftu | Pa | Ma
Decimzls 00000 0000 #HAH HAEE Hoge
| Beam
|ID | Description | Ivy | lud | F tu |H allow |T_TE|E|:1
1 2-in CH 0.0&30 a.710 45, 000 3,953 Yes -
Z2 3-in CH 0.2470 1.0e0 45,000 10,484 Yes
3 2 x 3-in CH 0.4540 1.500 45, 000 14,820 Yes
4 Z-in Tube 0.8500 1.000 45, 000 38, 250 Yes
|ID | Description | Ivy c | F tu |H allow |T_Tsled
-
[ Add Mew ” Delete ] [ |pdate ] [ Close J
Figure 7-3

The below figure shows a typical view of Material Edit Window (this example shows Beam view).
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*.mtl file name Decimals (Section 7.4)

/\ Icons (Section 7.3) ,—H /\

-

Malﬁials for Whiffletree Construction - [Material.mil] / =
== /% | | vy | oD | Feu | Pa | Ma
MTL | MTL )

Decimals 00000 0000 #HiEHE S8 HiE
| EBeam
|ID | Description | Ivy | c | F tu |H a2llow |Used
1 Z-in CH 0.0&30 0.710 45,000 3,933  Yes =
Z 3-in CH 0.2470 1.080 45,000 10,486  Yes
3 2 x 3-in CH 0.4340 1.500 45,000 14,820  Yes
4 Z-in Tube 0.8500 1.000 45,000 38,250  Yes
|ID | Description | Ivy c | F tu |H a2llow |Used
-
[ Add MNew ” Delete ] [ |Update ] [ Close J
Data Screen (Section 7.5) J L Edit Area (Section 7.6, 7.7 & 7.8)
Figure 7-4
7.3 Icons
wrL| Open material (*.mt]) file (Section 7.3.1)

Save material (*.mtl) file (Section 7.3.2)

MTL
/ Switch to rod material view (Section 7.3.3)

Switch to beam material view (Section 7.3.3)

7.3.1 Open Whiffletree Material File (*.mtl)

Click icon to open material (*.mtl) file that you have previously created. Default folder is the same
folder where 3DWhiffletree.exe is located. If you already have material data edited, then you will see the
following message.
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-

3DWhiffletree =

Do you want to save Material (.mtl] file before open new file?

Ve || Ne || Cancel

Figure 7-5

7.3.2 Save Whiffletree Material File (*.mtl)

Click icon to save material (*.mtl) file. Default folder is the same folder where 3DWhiffletree.exe is
located. When saving the file, the program always ask you to name the file. Therefore, the save function
works also as “Save As” command.

Both Rod and Beam data are saved in one file.

When closing Material Edit Window without saving material data, you will see the following warning
message. You can come back to Material Edit Window later to save the data. Until then, you won't lose any
data unless you exit 3DWhifletree program. (There won't be any warning message when you exit
3DWhiffletree data without saving material data, unlike the program does for the other files such as *.wtr
data.)

-,

3DWhiffletree ==

Do you want to save Material (.mtl] file?
(You can save it later by coming back to this window and as long as you don't exit
IDWhiffletree.)

Yes | I Mo ‘ I Cancel

Figure 7-6

7.3.3 Switch View between Rod and Beam

Click and to switch view between Rod and Beam. Information is slightly different between Rod

and Beam. See Data Screen (Section 7.5) for more details.

7.4 Decimals
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Ivy c, D Ftu Pz Ma
Decimals 00000 0000 HHEEH HHEHH Hif

This is very similar to “Units and Decimals” explained for Whiffletree Edit Window (Section 6.8) except there
is no “Units” to show for materials. The decimal is used only for a display purpose in Data Screen. See
Table 6-1 for detail explanation of formatting rules/

To complete editing decimals, click IUpd&I to confirm changes.

7.5 Data Screen

7.5.1 Rod

Figure below shows a typical Data Screen for rod. Table 7-1 provides explanation of each item in Data

Screen.
Bod
ID Description Dia F tu P 2llow |Used
1 3/8-in Red 0.375 45,000 4,97 Yeg
2 1/2-in Rod 0.500 45,000 8,838 Yes
Figure 7-7
Table 7-1
ltems Explanations
ID ID is only for listing purpose. Not relevant to any computation.
. Description is used to identify the rod. It will also appear in whiffletree diagram
Description . ;
when showing materials.
. Diameter of rod. This is for information only and not a parameter of selecting rod

Dia - . L . .
at the time showing materials in whiffletree diagram.
Ultimate tensile stress of the rod material. This is for information only and not a

Ftu . . . o . .
parameter of selecting rod at the time showing materials in whiffletree diagram.
Allowable tensile load of the rod (maximum load that rod can take). This is only

P allow the parameter of selecting rod at the time showing materials in whiffletree

diagram.
The value is either “YES” or “NO” and it determines if the particular rod can be

Used selected at the time showing materials in whiffletree diagram. For example, if you

have a rod that is out of stock but want to keep the information in the list for future
purpose, then set the value to “NO” so that it won't be selected as a valid material.
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7.5.2 Beam

Figure below shows a typical Data Screen for beam. Table 7-2 provides explanation of each item in Data

Screen.
Beam
D Description Ivy C F tu M allow |Used
1 Z-in CH 0.0820 0.710 45,000 3,933 Yes .
Z 2-in CH 0.2470 1.08&0 45,000 10,488 Yes
2 Z x 3-in CH 0.4340 1.500 45,000 14,820 Yes
4 Z-in Tube 0.8500 1.000 45,000 38,250  Yes
Figure 7-8
Table 7-2
ltems Explanations
ID ID is only for listing purpose. Not relevant to any computation.
_ Description is used to identify the beam. It will also appear in whiffletree diagram
Description

when showing materials.

The second moment of inertia of the cross-sectional area computed about the
lyy neutral axis of the beam (see figure below). This is for information only and not a
parameter of selecting rod at the time showing materials in whiffletree diagram.

The perpendicular distance from the neutral axis to a point farthest away from the
c neutral. This is for information only and not a parameter of selecting rod at the
time showing materials in whiffletree diagram.

Ultimate tensile stress of the beam material. This is for information only and not a

Fi parameter of selecting rod at the time showing materials in whiffletree diagram.

Allowable bending moment of the beam (maximum bending moment that the
M allow beam can take). This is only the parameter of selecting beam at the time showing
materials in whiffletree diagram.

The value is either “YES” or “NO” and it determines if the particular rod can be
selected at the time showing materials in whiffletree diagram. For example, if you

Used have a beam that is out of stock but want to keep the information in the list for
future purpose, then set the value to “NO” so that it won't be selected as a valid
material.

Form the figure below, lyy can be calculated as

Iy, = ”zzdxdz (The second moment of inertia)

View and Edit Whiffletree Material Rev 2015-08-13 7-6



3DWhiffletree Version 1.4.0 User’'s Manual Copyright © 2013-2014 Yoji Hosoe

o

Bending Moment

T i

v . N.A.
X¢

Area (A)

Figure 7-9

7.6 Add New

Take the following procedure to add new material.

1. Click or to switch view to desired material (rod or beam).

2. Enter information. (See sub sections for detail of each item). As minimum, only description is required to
create a new material. If you don’t enter description, you will see the following message.

3DWhiffletree ==

-

Description cannot be blnak.

Figure 7-10

3. Click to confirm new the new item. The new item will appear in Data Screen.
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Materials for Whiffletree Construction - [*.mtl] @
=0 /ﬂ%‘ Iyy | e,0 | Ftu Pa M=
- Decimals 00000 0000 Hish HHHH HHH

Bod
D Description Dia F tu P 2llow |Used

Enter information

ID Description Dia F tu P 2llow |(Used

3/84in Rod 0375 45000 4570 Yes -

\
\—@ Click Button to confirm

Figure 7-11

7.6.1 Rod

D Description Dia F tu PF z2llow |Used

To add a new rod material, fill out the information per the notes given in the following table.
Table 7-3

Items Value Explanations

Description Required  Enter description of the rod material. Any character lengths are accepted but
simple expression is recommended as it will appear on whiffletree diagram.

Dia Optional  Enter a diameter of rod.
Ftu Optional  Enter ultimate tensile stress of the rod material.
P allow Optional  Enter ultimate tensile strength in terms of load (i.g., Ib or N). If it is left blank,

the value is automatically calculated as

Poow =F

1
allow tu Z TCDZ

If values are entered and the value does not match calculated value, user will
see a message to select which values the user wants to use.

Used Optional  Choose “YES” or “NO” from dropdown menu. If left blank, “YES” is assigned
automatically.

View and Edit Whiffletree Material Rev 2015-08-13 7-8



3DWhiffletree Version 1.4.0 User’'s Manual Copyright © 2013-2014 Yoji Hosoe

7.6.2 Beam

D Description Ivy C F tu M allow |Used

To add a new beam material, fill out the information per the notes given in the following table.
Table 7-4

Items Value Explanations

Description Required  Enter description of the rod material. Any character lengths are accepted but
simple expression is recommended as it will appear on whiffletree diagram.

lyy Optional  Enter the second moment of inertia of the beam cross section.
c Optional  Enter distance from neutral axis to the furthest point of the beam in the cross

section.

Ftu Optional  Enter ultimate tensile stress of the beam material.

M allow Optional  Enter ultimate tensile strength in terms of bending moment (i.g.,in- b or
Nmm). If it is left blank, the value is automatically calculated as
_ Fu -y
allow c

If values are entered and the value does not match calculated value, user will
see a message to select which values the user wants to use.

Used Optional  Choose “YES” or “NO” from dropdown menu. If left blank, “YES” is assigned
automatically.

7.7 Update

The material in the list can be updated.

1. Select material in the list by clicking the item on Data Screen.
2. ltems will appear in Edit Area.

3. Edititems you want to update.

4. If you want allowable values (P allow, M allow) being calculated automatically, leave the item block
blank.

5. Click lﬂl to confirm the change.
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6. Listed items in Data Screen will be updated. (Remember to save the *.mtl file if you want to save

the change.)

O

elect an item

HEA4

Materials for Whiffletree Construction -/[Material.mtl]

==

|Iyy|c,D|Ftu|Pa |Ha

Decimals 00000  0.000

| / Beam
| ID | Descrlptin% | Ivy | c | F tu | M =2llow |Used
1 Z2-in CH 0.0&830 0.710 45, 000 3,953 Tes -
Z 3-in CH 0.2470 1.080 45,000 10,488 Yes
4 Z-in Tube 0.8500 1.000 45, 000 38,250 Tes
ID | Description | Ivy c | F tu |H 2llow |Used
3 | 2x3HnCH 0.494 15
| AddNew || Delete | / Update

@ Selected item is displayed.

/
Edit values. @—/

Make the box blank if you want auto-calculation.

o © o

|ID | Description | Ivy | c F tu M a2llow |T.Tsed
1 Z2-im CH 0.0830 0.710 45,000 3,953 Yes -
2 3-imn CH 0.2470 1.0&0 45 000 10, 4846 Yes

|2 2z x 3-in CH 0.4540 1.500 g3, 000 20,748 Yes |
4 Z-in Tube 0.8500 1.000 45, 000 38,250 Yes

\—@ Item is updated.

Remarks

Figure 7-12

View and Edit Whiffletree Material
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If “P allow” or “M allow” that user entered (except for blank entry) does not match the calculated value, the
following message will appear asking user to select which values users want to use. This situation most
commonly happens in the following situation

1. When user wants to update values but forget to update/enter allowable value

2. When user wants to enter his own allowable value.

ADWhiffletree £3

You entered P_allow which does not match the calculated value, Do you want to
overwrite?

Click Yes to use your entered value: 8835.720338
Click Mo to use calculated value: 19880,3910109979

Figure 7-13

7.8 Delete

Items in the list can be also deleted.
1. Selectitem that you want to delete.

2. Items will appear in Edit Area.

3. Click to delete. IDs are automatically updated in the list.

4. Listed items in Data Screen will be updated. (Remember to save the *.mtl file if you want to save
the change.)

View and Edit Whiffletree Material Rev 2015-08-13 7-11
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Select an item
—O

— —

Materials for Whiffletree Construction - {Material.mtl] =
‘—‘HL/‘M | |Iyy|r_',D|F1:u|Pa |Ha

MTL| MTL |Decimals 00000 0000 HEHH #H#e Ha
| / Beam
|ID | Descriptim}/ | Ivy | c | F tu |H allow |Used

1 2-in CH 0.0830 0.710 45,000 3,993 Yes =

Z 3-in CH 0.2470 1.0&0 45,000 10,488  Yes

4 Z-in Tube 0.8500 1.000 45,000 38,250  Yes

ID | Description | Ivy c | F tu |H 2llow |Used

3 |2x3inCH 0.454 1.5 45000 14320 fes -

AddNew || Delete |- | Update || Close |
Selected item is displayed. .

@ Pay 3 ) Click button to delete.

|ID | Description | Ivy | c | F tu M allow |Uaed

1 Z2-in CH 0.0830 0.710 45,000 3,993 Yes | =

Z 3-imn CH 0.2470 1.0&0 45,000 10,488  Yes

2 Z-in Tube 0.8500 1.000 45,000 28,250  Yes

@ Item are updated.
Figure 7-14

View and Edit Whiffletree Material
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8.0 VIEW WHIFFLETREE DIAGRAM

This section explains how to review whiffletree diagram in Whiffletree Diagram Window.

Whiffletree Diagram Window can be accessed by the following icon or File Menu.

=2 Ila]2
N X

[ Lo )
¥ ir:"
ke &

“

ratdtl
PAIFEE

8.1 General View

or .
File

Figure 8-1

View

Whiffletree | Help

Open File

Save File

Change Bearn Size 3

Yiew ar Edit Material

IWhif‘FIetree Diagram I
Export to Catia

—  —

The figure below shows a general view of Whiffletree Diagram Window.

View Whiffletree Diagram
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Whiffletree Diagram Preview /

Font Size (Section 8.3.6)
Units and Decimals
ﬁ Icons (Section 8.2) / (Section 8.3.7)

—IE Decimals
E 10 TESTSF 17851b ]
ww || (Bar 561 Fwd 3G) wssin Cart (Fwd-Otbd)
H 5,499 Ib
EB1in
627in| 47131b
JI' ——————— Structure
B 10,070 b
E 357in
1,785 1b )
. sainl Cart (Af-Otbd)
* 10.210in| 3571 1b
- _
822in| 1 7381b
—————— CartiAft-Inbd)
13,950 Ib 179 b .
s2ainl Glass Rack Lower (Content)
1,488 Ib
1.45in
0.85in| 1 308 1b
——— Refrigerator
1,666 |b
1623 in
12.07in| 17910
Glass Rack Upper (Content)
9.27in| 3,880 b

428 Ib
winl Attendant Module

12.22in| 22141b

Cart (Fwd-Inbd)

7\/ 8.91in| 1,785 1b

: o
7

Window Size Adjust (Section 8.3.5)

Model Window (Section Error!

Figure 8-2
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8.2 Icons

E Auto fit whiffletree diagram to the current window size (Section 8.3.2)

Enlarge whiffletree diagram in vertical direction (Section 8.3.2)

Contract whiffletree diagram in vertical direction (Section 8.3.2)

E| Enlarge whiffletree diagram in horizontal direction (Section 8.3.2)
E—I Contract whiffletree diagram in horizontal direction (Section 8.3.2)

= Zoom in whiffletree diagram (Section 8.3.3)
| Shortcut Key: Scroll down the mouse wheel

Zoom out whiffletree diagram (Section 8.3.3)
Shortcut Key: Scroll up the mouse wheel

-
—E Show whiffletree labels (Section 8.4.1)

—E Show whiffletree IDs (Section 8.4.2)

_—L]_: Check whiffletree completeness (Section 8.4.3)

Show whiffletree materials (Section 8.4.4)

Hﬁ Show rod tensile load and beam bending moment (Section 8.4.5)

Copy image (Section 8.5)

éi
@ Export whiffletree diagram into Microsoft Word 2010 (Section 8.6.1)

a
%
[ 2|

Export whiffletree diagram into Microsoft Excel 2010 (Section 8.6.2)

L

8.3 View Operation

This section explains operation related to whiffletree diagram view.

View Whiffletree Diagram Rev 2015-08-13 8-3
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8.3.1 Model Window

Whiffletree ID CG Poi
. P in
Whiffletree Description oints
14
ID: TESTSF 1736 1b .
= |iBar 561 Fwd 8G) 16.580n Cart (Fwd-Otbd)
6,499 Ib
E&1in
6.27in
471310 Structure
10,070 |b
357in
1,785 1b .
323in Cart (Aft-Otbd)
102100 357 Ib
8.22in
1,785 1b Cart (Aft-Inbd)
13,850 Ib
L 178 1b
824in Glass Rack Lower (Content}
1,488 Ib
1.45in
0.85in| 13091b
Refrigerator
1,666 |b
1623 in
12.07in| 17910

Glass Rack Upper (Content)

9.27in| 3,880 b

428 1b

3711in Attendant Module

1222in) 22141b

881in| 1786 1b

Cart (Fwd-Inbd)

Edit Whiffletree - [S61WhiffleTree2 wir] =
__I ID TESTSF Case Description Bar 561 Fwd 3G I L W M
Pull Direction - G-Factor 50 |other Factors 1.15,1.15 RS n Ib indb
- Decimals 000 HHHH HHAH
Warning Length 20
Ho Description Weight X T Z Load Length
1 Structure 338 ele.931 -75.73 243 42 4,713 a.a0 -
z Cart (Fwd-Inkd) 150 &00.80 -71.00 2z1.352 1,785 a.a0 "
3 Cart (Fwd-Othkd) 150 &00.80 -87.45 ZZ1.352 1,785 a.a0
4 Cart (Aft-Inkd) 150 &13_20 -71.00 2z1.38z2 1,785 a.a0
5 Cart (Aft-Otkd) 150 elZ. 20 -E7.345 221 52 1,785 0.700
1 Refrigerator 110 &lE8.47 =78.%0 25&.20 1,309 Q.00 =
7 Glzss Rack Lower (Content) 1= =00.28 -74.6% Zel.28 173 0.00
=] Elass Rack Upper (Content) 15 &®00_28 -74_86 269 _87 179 a.aa
=] Attendant Module 36 629 .68 —-g8._80 287 _87 428 a.a0
10 Hod: from 4 €18._39& -71.00 2z1.352 1,785 = B
11 Bod: from 5 &l8._3& -87.45 2z1.352 1,785 8.z3
1z Beam: between 10 & 11 el8._36 -75_.23 ZZ1.352 3,571 a.a0
Figure 8-3

8.3.2 Fit Buttons

View Whiffletree Diagram Rev 2015-08-13 8-4
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e
i}

Auto fit and center

This button will center the whiffletree diagram and auto-fit the diagram to the current window size. This is the

default setting when opening Whiffletree Diagram Window.

ID: TESTSF
(Bar 561 Fwd 9G)

10,070 Ib

1785 1k

i Cart(Fwd-Otbd)
E&n
581in N
827in
4713 1b Structure

357in

13,950 |p

9.27in

1623 in

3,880 b

223 178 ot (af-Otbe)
1w021in| £51
8.22in| 17851b
Cart (Aft-Inbd)

Glass Rack Lower (Content)

Refrigerator

1207 in| 17910
Glass Rack Upper (Content)

1222in| 221416

428 b

Attendant Module

3711in

891in| 17851b
Cart (Fwd-Inbd)

Figure 8-4

Adjust vertical size

s
Ll

1D: TESTSF
(Bar 661 Fwd 8G) 16.56 in
5499 b
E&1in
627in
10,070 Ib
3ETin
823in
1021in| 3571 b
8.22in
13,850 Ib
6.24in
1488 Ib
1.45in
0.85in
1,668 Ib
16.23in
1207in| 17910
827in| 388010
371in
1222in| 22141b
891in

1788 1b

4713 1b

1788 1b

1788 1b

1791b

1,309 1b

428 b

1,785 1b

Cart (Fwd-Otbd)

Structure

Cart (Af-Otbd)

Cart (Aft-Inbd)

Glass Rack Lower (Gontent)

Refrigerator

Glass Rack Upper (Content)

Aftendant Module

Cart (Fwd-Inbd)

This button will adjust whiffletree diagram in vertical direction.

View Whiffletree Diagram
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ID: TESTOF
(Bar 561 Fwd 9G)

357in

927in

13,950 Ib

1.7851b
561 in m_47131b
10,070 18
1,785 1b
10.211n) 3571 823 in
ZZT| 1,785 b
179 1b
1,488 115,24 in
1,685 144510 mLie
18.231n 1207 in
3,880 Ib
428 b
12.22in| 221410 37.110n
| 1738510

Adjust horizontal size

This button will adjust whiffletree diagram in horizontal direction.

1D: TESTSF
(Bar 581 Fwd 9G)

lsségﬂ (Fwd-Otbd)

9 1b
4713,
LA eture

3567in

LTS, abart (Aft-Otbd)

F1lb

8.22in
L1785, abart (Aft-Inbd)

50 1b
L ‘%\ass Rack Lower (Content)

624in
14

8 1o

1.45in

L2 gerator

Glass Rack Upper (Content)
927in

428 |
g\ﬂendantModu\e

12.22in| 221418

8.91in| 178500

art (Fwd-Inbd)

ID: TESTOF
(Bar 561 Fwd 9G) 8.27in
4713 b Structure
10,070 Ib
3.57in
1,785 b .
m sasin[ Cart (Afl-Otbd)
1021in| 387110
Cart (Fwd-Otbd) 822in
L 17e5 Cart (Aft-Inbd)
Structure
Cart (Aft-Otbd)
Cart (Aft-Inbd)
13,960 Ib 17918
Glass Rack Lower (Contert) §24in Glass Rack Lower (Content)
Refrigerator
1488 1b
Glass Rack Upper(Content) 1.45in
Aftendant Module 0.85in| 1309 1b
m Refrigerator
Cart (Fwd-Inbd) 1,668 b
16.23in
12.07in| 1791b
Glass Rack Upper (Content)
8.271in| 3,3801b
a7 in’L Attendant Module
Figure 8-5
1D: TESTSF 1,785 b
(Bar 561 Fwd 8G) 1658 in Cart (]
54%91b
5681in
827in| 4T3 1b
Structy
10,070 1b
;
1,785 b
823in Cart
1021in| 3571 1b
8.22in
1,785 1b cart 4
—| 1781k
824in Glass
1,488 Ib
1.45in
0.85in
1,309 b Refrig
1,668 Ib
18.23in
1207 in
1791 Glass
7in| 3,8801b
428 b
3TAin Aftend
1222in| 22141b
8.91in| 1785 b
Cart(H

Figure 8-6

View Whiffletree Diagram
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8.3.3 Zoom In and Out Buttons

= = .
Zoom in and out

This button will zoon in and out the whiffletree diagram. It does not change font size. See Section 8.3.6 for
how to change font size in whiffletree diagram.

8.3.4 Mouse Controls

Left Mouse Drag Pan-move the whiffletree diagram.
The pan-move is only available by mouse.

Middle Button Wheel Zoom in and out the whiffletree diagram.

ID: TESTSF
(Bar 561 Fwd 9G)

Drag diagram by
mouse left button

.

.

.

.

.

.

.

.

.

.

.

. sanssnsssnnunnnnnnnnnfannnunnnnnnw

. . = ]

. . . .

- . I-"-i' ; 178518 moyy (Fyg-Otocy) -

: : 172 :

. . 581l ga7in| 4713 -

M M sStructure M

. . 10,070 1b . .

= = 357in = .

1735 b

. . .

. . . 5200 wCart (4f-Otbd) H

- L] nLs o - -

= . 8.22in = .

. . LT ot (ot b .

. . " .

. . . .

13.050 )

. — £2ai 17810 Glass Rack Lower (Gontent/s

. . £A41 : .

LR R PR PRy v o (R H

in
= 1,686 1t 13 efrigerator .
. 16231 .
in

- kL Glass Rack Upper (Conterty
. .
. .
- Attendant Module =
. .
. .
. .
M Cart (Fwd-Inbd) M
AEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEES

Figure 8-7

Zoom In (Scroll Back)

Zoom Out (Scroll Forward)

Figure 8-8
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8.3.5 Change Window Size

Sometime figures overlap due to the size of window if you build big whiffletree constructions. In such cases
you can adjust window size by dragging a corner of window (or right vertical edge or bottom horizontal
edge) to adjust window size until overlapping figures are gone.

Whiffletree Diagram Preview

|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
t
|
|
|
|
|

Fort | Units
L ) Wil |
EoEAR I TIES 2] o
1D: TESTSF 893 1b
(Bar 561 Fwd 9G) i Cart(Fwd-Ctbd) - Split 1/2
18.56in
W0 Gart(Fwa-Otoal) - Spiit22
m 561in 2,357 1b ;
a27in Structure - Split 172
E 10,070 1b ructure - Split 212
= 357in
1,785 1b
= 523in Cart (AR-Otb
o 10.21in
— Cart (Aft-Inkd) - Split1/2 ™~
-\ — . .
Cart (Afi-Inbd) - Split2/2 > Overlappn’]g f|gures
-1
780in L Glass Rack Lower (C;
split 12
13,951 1 10016
< ack Lower(Gontent -
+E7in DIt 2/2 - Spiit 12
Glass Rack Lower(Content) -
+&7in Split 22 - Split 202 - Split 172
145in
Glass Rack Lower (Content)-
Split2/2 - Split 202 - Split2/2
1,868 1b| 0.85in| 13081b
16231n
331b
Glass Rack Upper(Content-
12.07in| 17810 824in Spiit iz peerl
824in| g31b
9271 388110 Glass Rack Upper(Cantent -
split2/2
21410
Attendant Module - Split 172
BN "
37 in[ 7.42in| 2141p
1223in| 22141b Attendant Module - Split2i2
8.31in| 1,7851b
Cart (Fwd-Inbd)
o~
| —
I _—
L ______________ T
Whiffletree Diagram Preview
Fort | Urits
£ |4 T m] :
[EH H o) IR 8 2| Decimsls
[ | 1o restor 583 1b
> || (Bar 561 Fwa sg) 79816 37210 Cart{Fwd-Otbd) - Split 172
16561 372in
Hi g2 lb Cart(Fwd-Otod) - Split 272
ﬁ 5489 1b
561in 2,357 Ib
627in| 471310 465in Structure - Split 12
485in
E 10,070 1b 235710 Structure - Split 212
= 357in
1,785 1b
= 523in Cart (Afl-Otbd)
10:21in| 357110 03 1b
Cart (Afi-Inbd) - Split1/2
8.22in| 1,7551p 457in r Anba)- Spif
457in
B9k Cart (Aft-Inbd) - Split2/2
7800 &l Glass Rack Lower(Content -
Split /2
150 1b 50
EEELCI N 821in a87in Glass Rack Lower(Gontent)-
770in| s Split2/2 - Split 172
231b
. Glass Rack Lower(Content)-
L 1483 b 487in| 45)p  399in Split 272 Split 212 - Split172
n 389in
=1t Glass Rack Lower(Content -
Split2/2 - Split 212 - Split2/2
1,668 Ib 0.85in
1823in 1 Refrigerator
591b
Glass Rack Upper (Content)-
12.07in| 173 1b 824in Split 12
824in
927in| 388116 b Glass Rack Upper (Content) -
Split2/2
2141p
P Attendant Module - Split 172
I ATin 7.42in| 2141p
1223in| 22141 AttendantModule- Split2i2
881in
178810 Cart{Fwd-Inbd)

Figure 8-9

Drag this corner to adjust window size

View Whiffletree Diagram
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8.3.6 Change Font Size

Font
8=

Font size in the whiffletree diagram can be changed to any size between 1 and 10. The default size is set to
8.

1,785 Ib _ 1.785 b
wssinl Cart(Fwd-Otbd) 656in Cart (Fwd-Othd)
8,495 |b 6,499 b
82T 627in| 4713 1b
nparisib Structure ———— Structure
Default Font Size = 8 Largest Font Size = 10

Figure 8-10

8.3.7 Unit and Decimals

Units in [i] indb

n F Hpar | A R

Decimals | 0.00 | &

The current format of units and decimal display are shown. As they are shown in gray, they cannot be
changed from Whiffletree Diagram Window. To change the units and decimal format, go to Whiffletree Edit
Window to update values (Section 6.8) and come back to Whiffletree Diagram Window.

1,785 b ) 1,785 M ) )
wesinl Cart (Fwd-Otbd) 17 mm Cart (Fwd-0Otbd)
545518 159588 in-Ib 649N 29,558 Nmm
£8.27in & mm
| 47138 Structure A L E— Structure
Urits i [ indb Lnits mm M Mmm
Decimals | 0.00 |# x| # i Decimals 0 | Heh | Hih

Figure 8-11

8.3.8 Additional Remarks about View Operation

You can NOT save view setting.

View Whiffletree Diagram Rev 2015-08-13 8-9
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The view setting cannot be saved to whiffletree data (*.wtr) file. For example, following changes made to
whiffletree diagram will not be saved. Once you exit 3DWhiffletree and next time you open the whiffletree
data file, all changes will be back to default values even though you save whiffletree data (*.wtr) file.

e Size and Position of Whiffletree Diagram

e Size of Font
e Size of Whiffletree Diagram Window

8.4  Whiffletree Diagrams Functions

This section explains several functions to display whiffletrees in different ways.

8.4.1 Show Basic Whiffletree
By default, this button is on when Whiffletree Diagram Window is opened. This button automatically turns off
when showing materials or bending moment. Usually, users do not need to touch this button unless they

want to turn off basic whiffletree items for some purposes. (You cannot get rid of item names or basic
whiffletree structures.)

1D: TESTSF 1.7851b 1D: TESTSF
(Bar 561 Fwd 9G) tessin[ Cart{Fwd-Otbd) (Bar 561 Fwd 5G) [ Cart(Fwd-Otbd)
6,498 Ib
561in
827in
A3 Srcture L———— stucture
100701
357in
823in LIS ant (ar-Otba) ——— Cart (Af-Otbd)
10.21in[ 35711b
822in
LLTES0 ot (st inb) L CartiAftinbd)
13,950 Ib 1751
8.24in Glass Rack Lower (Content) [ Glass Rack Lower (Content)
1,488 Ib
1451n
085in
130910 pofrigerator L Refrigerator
1,666 Ib
16.231n
1207in| 17916
Glass Rack Upper (Cantert) L Glass Rack Upper (Content)
9.27in| 33880 1b
428 1b
T11in AttendantModule [ Attendant Module
12221n| 22141b
591in
1780 ot (Fwe.inba) L CartiFwd-Inbd)
Figure 8-12

8.4.2 Show Whiffletree ID

15

View Whiffletree Diagram Rev 2015-08-13 8-10



3DWhiffletree Version 1.4.0 User’'s Manual Copyright © 2013-2014 Yoji Hosoe

Whiffletree beam IDs can be turned on to identify each beam to help manufacturing and inspection.

5] o 5| oe

1,785 b ) . 1,109 I . )
weainl— Cart (Fwd-Otbd) BEEIn Cart (Fwd-Otbd)
. 6,489 |b ESTOF-20 . 5,488 Ib
E&1in E&1in
B27in| 47131b 8.27in
————— Structure | 471316 Structure
——ITESTSF-31 _—
1,785 b ) 1,785 b .
] E— Cart (Aft-Otbd) g2in Cart (Aft-Othd)
10.21in| 3571 b ESTOF.12 10.21in| 3571 1b
8.22in| 17851b \ 3.22in| 1,785 1b
———— CartiAft-Inbd) —————— Cart(Aft-Inbd)
Figure 8-13

Remarks
1. ID can be set in Whiffletree Edit Window (Section 6.2).
2. Dash numbers after ID shown on the whiffletree diagram are automatically assigned and cannot be

edited.

8.4.3 Check Whiffletree Completeness

It is always good to check whiffletree completeness when having its diagram. Clicking the button brings a
new window with summary of whiffletree. It will show a summary of 4 check items:

View Whiffletree Diagram Rev 2015-08-13 8-11
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ltems Explanations

Connection

Overall Load

Overall CG

Beam Moment Arm

Table 8-1

This checks if all CG Points are connected. If “Non Connected CG” is
zero, then, whiffletree is considered completed.

This compares the final load on the whiffletree against calculated
overall load from weight times factors.

This compares the final loading point against the calculated overall
cg location of the all CG Points. The overall cg will not match in the
loading component, but other component should match. If the
connection check shows that whiffletree is not completed, then, it
does not provide comparison results.

This shows the current Warning Length for moment arm and number
of arms that are shorter than the defined warning length.

3DWhiffletree

-

[l

Hon Connecte
Whiffletree

R

Total Weight
Total Factor
Weight x Fac

Final Load

——Whiffletree Check Results--

1. Connection Check

- Overall Load Check

3. COwverall CE Check

dcz =20
Completed ... Yes

=1,172 1b
= 11.30% (= % = 1.15 = 1.1%5)
tor = 13,950 1b

= 13,5350 1k

Crrerall CE (H) = &08.57
Whiffletree Final Loading (¥X) = T27_.54
Cwrerall CE (¥) = -T78.54
Whiffletree Final Loading (¥) = -78.94
Crerall CG (Z) = Z234_%594
Whiffletree Final Loading (Z) = Z34_94
4. Beam Moment Arm
Warning Length = Z2.00 imn
Number of Short Arms = 2
——End of List—-—
Figure 8-14

View Whiffletree Diagram
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8.4.4 Show Whiffletree Materials

I

This button will show whiffletree materials in the diagram. Following rules apply

1. Rod and beam materials need to be defined prior to show whiffletree diagram. See Section 7.0 for how

to define rod and beam materials.

2. Rod and beam are selected based on the tensile load in the rod or bending moment in the beam. Rod

or beam with the lowest allowable above the required load or bending moment will be chosen.
3. No materials will be selected if “Used” value is set to “NO” in material data (Table 7-4)

4. |If there is no rod or beam available to meet required load or bending moment, then “No Rod” or “No

Beam” in red color will be displayed.

ID: TESTSF 3/8-in Rod .
(Bar 581 Fwd 9G) ———— Cart(Fwd-Otbd)
1/2-in Rod 2.in Tube
3/8-in Rod
[ feinnee Structure
Mo Red 2-in Tube
—HEinRed oo (af-Otbd)
3/8-in Rod 2% 3in CH
3/8-in Rod
L =B P08 Cart (Aft-Inbd)
Mo Rod . 3/8-in Rod
2-in Tube —nnee Glass Rack Lower (Content)
38-inRed |5 eop
3/8-in Rod
. L RLLLLLL . Refrigerator
3/8-in Rod 2.in CH
3/8-in Rod
nRoe Glass Rack Upper (Content)
3/8-in Rod 2.in Tube
~inRod Aftendant Module
3/8-in Rod 2in Tube
[ 28inRed o (Fwdinbd)
Figure 8-15

8.4.5 Shown Tension Load and Bending Moment
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To verify that the correct materials are chosen, you can see load in each rod and bending moment in each
beam.

fop) on \Mﬂ

1,785 b ) [T =-21% . )
wgssin[ CartiFwd-Othd) 1BEsin T Cart(Fwd-Otbd)
cetin 6,495 b EB.EESin—Ibl cetin 6,495 |b
627 in 8.27in
| 47131 Structure [ 471300 Structure
—— 5,480 in-1b _
1,785 b . 1,785 |b .
az3in[ — Cart(Af-Otbd) ga3in[——— — GCart (Afi-Otbd)
102100 367116 4635 in-lb 10.210n| 3871 1b
822in| 1,7851b . 822in| 1785 1b
——————— CartiAft-Inbd) ——— Cart (Afl-Inbd)
Figure 8-16

8.5 Copy Image
-
Clicking this button will copy the whiffletree diagram image (screenshot) into your computer’s clipboard.

8.6 Export Diagram

Whiffletree diagram along with detail data table can be exported into Microsoft Word or Microsoft Excel. The
difference in the output between Word and Excel is shown in the table below.

Table 8-2
Export to Differences
Word e Data table is given in Word table format (editable).

o Whiffletree Diagram is given as a screenshot (non-editable).

Excel e Data table is given in Excel cells (editable).
o Whiffletree diagrams are drawn by using cell boarders.

e Values in the whiffletree are given in text as cell values
(editable)

e Excel format has more control and freedom to edit or
touchup values in the whiffletree diagram.

View Whiffletree Diagram Rev 2015-08-13 8-14
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8.6.1 Exportto Word

w

Clicking the button will start exporting diagram into Word file. You'll see progress in the Whiffletree Model
Window. It should only take several seconds depending on the size of whiffletree and should not be long.

Output Word file includes:

e Whiffletree Summary
¢ Whiffletree Data Table
o Whiffletree Diagram

Whiffletree Diagram Preview = I@

el o [ T o em 5] x5 e D s

A
Tt

A nmEER

ID: TESTOF 1,785 b

(Bar 561 Fwd 8G) wssinl Cart (Fwd-Otbd)
5,499 b
E&1in
Exporting to MS Word ... 54 % completed. :
10,070 b
357in
323in 1,785 Ib Cart (Aft-Otbd)
10.21in| 35711k
B2zin| 17851 Cart (Aft-Inbd)

13,950 Ib 179 1b

6.24in Glass Rack Lower (Content)

1,488 |b

1.45in

0.85in| 1,308 1b
——— Refrigerator
1,666 b

16.23in

1207 in| 1781b

Glass Rack Upper (Content)
9.27in| 3880 1b

428 1b
37.11in Aftendant Module

1222in| 22141b

8.81in| 17851b
——— Cart(Fwd-Inbd)

Figure 8-17
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8.6.2 Export to Excel

Figure 8-18

Clicking the button will start exporting diagram into Excel file. You'll see progress in the Whiffletree Model
Window but generally output will be complete in a second.

Output Word file includes:

e  Whiffletree Summary
¢ Whiffletree Data Table
o Whiffletree Diagram

Because the exported whiffletree diagram and its values are not screenshot, you can edit or touchup the

values when desired.
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Whiffletree Diagram Preview = @
Fort Units in Ib indb
wil | (3 | s
E ID: TESTSF 1785 b )
% | | (Bar 581 Fwd 8G) wesinl Cart (Fwd-Otbd)
5,499 Ib
B&1in

Exporting to MS Excel ... 32 % completed.

B
=]
[E]

10,070 1b
357in
1,785 b .
823 in Cart (Aft-Otbd)
10.210n| 357110
8.22in
L 178516 Cart (Aft-Inbd)
13,850 Ib 1791b )
824in Glass Rack Lower (Content)
1,488 b
1.45in
0.85in| 1309 Ib
—————— Refrigerator
1,565 b
1623 in
12.07in| 17316
Glass Rack Upper (Content)
9.27in| 3830 Ib

428 Ib
37.11in Aftendant Module

1222in| 221410

8.81in| 17851b
——— Cart(Fwd-Inbd)

Figure 8-19
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Figure 8-20
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9.0 EXPORT TO CATIA

This section explains how to export whiffletrees in CATIA.

CATIA Export function can be accessed by the following icon or File Menu.

\

i %‘ 55

CATLA
— Open File
R 252 Save File

View ar Edit Material

or

File  VWiew | Whiffletree | Help

= 2] I
-

? ‘v
| e &

ratdtl
PAIFEE

Whiffletree Diagram

Export to Catia

Mo Bearn Length Warning

-_—

Figure 9-1

9.1 About CATIA Export

Figure 9-2
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3DWhiffletree can export whiffletree geometric data into CATIA as CATIA Part with points and lines as
shown in the figure above.

You need:

1. CATIA installed on your computer (tested with V5 R21),
2. CATIA launched, and

3. CATIA Part Design is opened and window is activated.

Once you create a CATIA Part Design for your whiffletree models, you can bring it into your CATIA Product
model to check physical properties such as interferences.

Figure 9-3

9.2 Export Window

The figure below shows a typical window for exporting whiffletree into CATIA.
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—— Whiffletree File Name (Section 9.3)

CATIA and Whiffletree Origin (Section 9.4)

CATIA and Whiffletree Coordinate
(Section 9.5)

Export to Catia @
Open Catia "Part Design” {exiting or new).

Whiffletree Data File (wirfile) 5511|'I.I’hrFFIeTr.aéZ wtr
7

Catia Origin 0.00 .00 0.00
Location on Whiffletree h89.00 £100.00 200.00
Catia Coordinate System +X +Y +Z

Whiffletree Coordinate System ¥ = +Y = +Z

1.0

Scale Factor = - - =
|@ Mo Scale ) Inchto MM ©) MMte Inch (©) Custom

[Sa\re Changes in .wir File ] [ Export ][ Cancel ]

\— Save Whiffletree File (Section 9.7)

Scale Factor (Section 9.5)

Figure 9-4

9.3 Whiffletree Data File

Whiffletree Data File (wirfile) | 561WhiffleTree 2 wir

This shows current whiffletree file (*.wtr). If no file is opened or saved, the file name is shown as “NA”".

9.4 CATIA Origin and Location on Whiffletree

o =
Catia Origin 0.00 (.00 0.00

Location on Whiffletree R35 -100 200

CATIA assembly origin is often different from FEM (or whiffletree) origin. To locate whiffletree diagram at
correct location in CATIA assembly, specify where CATIA origin is located in in whiffletree coordinate

Export to CATIA Rev 2015-08-13 9-3
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system. In other words, specify location of whiffletree diagram where the location is same as CATIA

coordinate (0, O, 0). Note that CATIA origin is always (0,0,0) and cannot be changed.

Specify where CATIA origin i~
located in whiffletree coordinate *
system.

In this example:
CATIA(0,0,0) = WT(589,-100,200)

N

200.00

[ ]

Figure 9-5

Export to CATIA
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9.5 CATIA Coordinate and Whiffletree Coordinate

Sometimes CATIA coordinate is different from whiffletree coordinate. For example, x-axis of the whiffletree

may be y-axis in CATIA coordinate. In such a case, you can specify whiffletree coordinate system to match
that of CATIA coordinate system.

The below example shows different exported whiffletree when whiffletree x-axis is flipped.

| Catia Coordinate System =X +f L ) ]
- CATIA X-coordinate is same as
| Whiffletree Coordinate System  |+X = | +7 + +Z = Whiffletree X-coordinate.

o [

| Catia Coordinate System X [« |[ -2z

= CATIA X-coordinate is opposite
|Wh'rFﬂetree Coordinate System |-}=: vI s - 2 - of Whiffletree X-coordinate.

Whiffletree flipped in X-coordinate.

Figure 9-6
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9.6 Scale Factor

1.0
| @ Mo Scale Inch to MM MM ta Inch Custom

Scale Factor

The scale factor will convert units between 3DWhiffletree and CATIA. There are predefined scale factors as
well as user-entered value. Following table summarizes the different scale factors.

Table 9-1
No Scale Scale Factor =1.0
There won't be any scales performed.
Inch to MM Scale Factor = 25.4
1 unit in Whiffletree becomes 25.4 units in CATIA.
MM to Inch Scale Factor = 0.03937

1 unit in Whiffletree becomes 0.03937 unit in CATIA.

Custom User can enter any scale factors.

9.7 Save Changes in .wtr File

Sawve Changes in wir File

This button will save information defined in CATIA Export Window such as location of whiffletree and
coordinate system.

Remarks:

W
1. Information in CATIA Export Window can be only saved through this window. Saving the file from \ﬂ‘
(main window) will not save information in CATIA Export Window.

2. The save button is only available if any exiting file is opened or whiffletree file has been saved. When
file name is shown as “NA”, the button is not enabled.

3. Ifyou click lﬂl without saving changes, you will see the following warning message. Clicking
No will let you stay in the window. Clicking Yes will close the window without saving changes you made.

-

ADWhiffletree 3

0K to close window without saving changes?

Yes l | [

Figure 9-7
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9.8 Export

Export
This button will create whiffletree diagram in CATIA Part Design.

Remarks:
1. Make sure that you have CATIA Part Design open and activated as follows

[indow [I0%

J Mew Window
Tile Horizentally
Tile Vertically

Cascade

=P [/ 1Partl

2 2106AD07016-601 H...738 (ReadOnly)

Figure 9-8

2. After clicking , you may see the following message if proper CATIA Part Design is not
activated. If so, check CATIA window.

-

3DWhiffletree ==

Error Occured. Check if you have launched Catia and opened Part Design.

oK

Figure 9-9

3. Ifthere is no error, CATIA will start importing whiffletree data and create points and lines in CATIA Part
Design. The following message will appear if whiffletree data are successfully exported into CATIA.

Export to CATIA Rev 2015-08-13 9-7
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3DWhiffletree ==

Whiffletree completed in Catia.

Figure 9-10
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